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Important Safety Instructions

This symbol, wherever it appears, alerts you to the presence of uninsulated dangerous voltage inside the 
enclosure -- voltage that may be sufficient to constitute a risk of shock.

This symbol, wherever it appears, alerts you to important operating and maintenance instructions in the 
accompanying literature.  Please read the manual.

1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this apparatus near water.

6) Clean only with a dry cloth.

7) Do not block any ventilation openings.  Install in accordance with the manufacturer’s instructions.

8) Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including am-
plifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug.  A polarized plug has two blades with 
one wider than the other.  A grounding type plug has two blades and third grounding prong.  The wider blade or 
the third prong are provided for your safety.  If the provided plug does not fit into your outlet, consult an electri-
cian for replacement of the obsolete outlet.

10) Protect the power cord from being walked on or pinched particularly at plugs, convenience receptacles, and the 
point where they exit from the apparatus.

11) Only use attachments/accessories specified by the manufacturer.

12) Use only with the cart, stand, tripod, bracket, or table specified by the manufactur-
er, or sold with the apparatus.  When a cart is used, use caution when moving the 
cart/apparatus combination to avoid injury from tip-over.

13) Unplug this apparatus during lightning storms or when unused for long periods of 
time.

14) Refer all servicing to qualified service personnel.  Servicing is required when the 
apparatus has been damaged in any way, such as power-supply cord or plug is 
damaged, liquid has been spilled or objects have fallen into the apparatus, the ap-
paratus has been exposed to rain or moisture, does not operate normally, or has 
been dropped.

15) WARNING -- TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, DO NOT EXPOSE THIS APPARATUS 
TO RAIN OR MOISTURE.

16) The AC mains plug, or appliance coupler shall be readily available to the operator as a means of power discon-
nection.

17) Unit shall be connected to a MAINS socket outlet with a protective earthing connection.
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Note: This equipment has been tested and found to comply with the limits for a 
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment.

This equipment generates, uses, and can radiate radio frequency energy and, 
if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful inter-
ference in which case the user will be required to correct the interference at this 
own expense.

CAUTION:  Changes or modifications not expressly approved by Lectrosonics, 
Inc. could void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) This device may not cause harmful interference, and 
(2) this device must accept any interference received, including interference that 
may cause undesired operation.
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General Overview
The architecture of a LecNet 2 sound system is built 
around a powerful digital matrix and bus structure com-
mon to all DM Series components interconnected in a 
system.  Data and audio signals are shared among the 
components through a digital bus called DANI (Digital 
Audio Network Interface).

In order to understand the power and functions avail-
able with this architecture it is helpful to think of the 
matrix as a separate entity from the hardware. Con-
ceptually, a DM processor is simply a hardware-based 
tap into the digital matrix to interface various types of 
microphones and audio equipment into the signal flow. 
The DANI bus interconnects the processors to allow 
them to share information about each input and output 
and to distribute the audio.

Multiple DM processors are “stacked” to configure 
larger systems, with one unit configured as the Mas-
ter at the “top” and the others as Slaves. There is no 
limit to the number of units that can be stacked to add 
inputs to a system. The number of outputs is limited to 
a maximum of 24. Literally hundreds of inputs can be 
configured with no “gas gauge” for DSP resources and 
still less than 4 ms of latency. The choice of processor 
model determines the number of final mix outputs at the 
Master unit at the top of the stack.

When multiple DM processors are stacked, each unit 
participates with the digital structure in several ways:

•	 Delivering	audio	signals	from	its	input	terminals	into	
the forward-propagated submix bus

•	 Passing	back-propagated	final	mix	signals	from	the	
unit above it to the next unit below it

•	 Applying	gain	and	signal	processing	to	the	audio	
signals at its input terminals

•	 Delivering	audio	signals	to	its	output	terminals	as	
selected by the setup

•	 Applying	signal	processing	to	the	signals	routed	to	
its output terminals

•	 Receiving	and	transmitting	data	required	for	the	
automatic mixing process in the matrix

The digital matrix is common to all processors in 
the stack, with automatic mixing taking place at the 
crosspoints in the digital matrix.  The output of each 
crosspoint is then available at a variety of output termi-
nals on various processors in the stack.

The DMPA12 digital power amplifier takes its input from 
the DANI bus, with each output able to source from the 
back or forward propagated signals (see block diagram 
on page 8). This architecture provides exceptional flex-
ibility to accommodate a wide variety of applications.
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The LecNet 2 product family includes a variety of com-
ponents to address a wide variety of applications. Differ-
ent processor models interface with the digital matrix in 
different manners.

Four basic matrix processor models are available:

	 •	 DM812	 8	in/12	out 
•	 DM1612	 16	in/12	out 
•	 DM1624	 16	in/24	out 
•	 DM84	 8	in/4	out

Each of these models provides mic/line inputs, exten-
sive signal processing and differential balanced outputs. 
Outputs are forward propagated to the Master unit in a 
stack, and the first 12 outputs are also back propagated 
to the Slaves in the system.

The DMTH4 telephone hybrid and DM84 processor 
contribute to all 24 forward propagated channels deliv-
ered to the Master in the system, even though each of 
them have only 3 or 4 physical outputs. The signals for 
these 3 or 4 outputs are selected from the first 12 final 
mixes back propagated from the Master.

Signal flow through the DANI bus

Master

Slave

Slave

Slave

Slave

EXPANSION

A BTX RX

RX TX

EXPANSION

A BTX RX

RX TX

EXPANSION

A BTX RX

RX TX

EXPANSION

A BTX RX

RX TX

EXPANSION

A BTX RX

RX TX

Audio Final Mix and 
Data Back Propagation

Audio Submix and
Data Forward Propagation

The DMPA12 digital power amplifier takes its inputs 
from the DANI bus. It can access either the first 12 back 
propagated signals from the system Master unit or the 
24 forward propagated channels.

The output amplifiers are a Class D type in a differential 
balanced configuration with each device providing two 
channels, sharing a ground on a common connector. 
The device is impervious to damage from shorts or 
thermal overload, and can drive loudspeaker loads from 
4 ohms and up. The outputs can also be wired in paral-
lel to double the available output power.

Because of the high efficiency of the Class D design, 
no special ventilation or fans are necessary, even in 
continuous duty at any power level.
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Two DMPA12 units configured as Master and Slave 
at top of stack to handle up to 24 outputs

Slave

Slave

Slave

Slave

Slave

EXPANSION

A BTX RX

RX TX

EXPANSION

A BTX RX

RX TX

EXPANSION

A BTX RX

RX TX

EXPANSION

A BTX RX

RX TX

EXPANSION

A BTX RX

RX TX

DMPA12 Slave

EXPANSION

A BTX RX

RX TX

DMPA12 Master

EXPANSION

A BTX RX

RX TX

Output Channels 1 - 12

Output Channels 13 - 24

Audio Submix and
Data Forward Propagation

DMPA12 configured as Slave at bottom of stack

Master

Slave

Slave

Slave

DMPA12 Slave

EXPANSION

A BTX RX

RX TX

EXPANSION

A BTX RX

RX TX

EXPANSION

A BTX RX

RX TX

EXPANSION

A BTX RX

RX TX

EXPANSION

A BTX RX

RX TX

Audio Final Mix and 
Data Back Propagation

Output Channels 1 - 12

Back Propagation - 12 channels
The DMPA12 digital power amplifier is 
typically configured as a Slave in the 
system using the first 12 back propa-
gated final mix signals labeled “Final 
Mix” in the GUI.

See the RED signal path.

DMPA12 System Configuration

Forward Propagation - 24 channels
If more than 12 outputs need to be 
amplified, two DMPA12 units can be 
configured at the top of the stack, one 
as a Master and one as the uppermost 
Slave. In these positions, both units 
can make use of the forward propagat-
ed signals from the Slave units below 
them labeled “FP Main Mix” in the GUI.

See the BLUE signal path.
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SHARC is a registered trademark of
Analog Devices, Inc.

USB 
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RS-232
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Controller
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LecNet 2 Conn
1/8 '' Jack

Front & Rear
USB B Conn

Control Signals

811

12 
A/DOutput Volume Control Pots
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Tx

Tx

Rx

Rx

Digital
Audio

Network
Interface
(DANI)

12 + 2 Submix + Mix Control

12 + 2 Submix + Mix Control

12 + 2 Mix + Mix Control

12 + 2 Mix + Mix Control

Sync Audio Frame Sync

Quad RJ-45 Conn Pink Noise Generetor

1 kHz Tone Generator

Third Generation 
SHARC ®  DSP

Out 1

Out 2

Out 3

Out 4

12 output tricolor 
signal indicator 

LEDs

Signal Processing D/A

Signal Processing D/A

Signal Processing D/A

Signal Processing D/A

Signal Processing D/A

Signal Processing D/A

Signal Processing D/A

Signal Processing D/A

Signal Processing D/A

Signal Processing D/A

Signal Processing D/A

Signal Processing D/A

Out 12

Out 11

Out 10

Out 9

Out 8

Out 7

Out 6

Out 5

Off: No signal
Green: Signal present
Orange: Compressor active
Blinking orange: Fault
Red: Limiter active
Blinking red: Channel muted at front panel

DMPA12 Functional Block Diagram
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Output Processing
Extensive signal processing is available at each output, 
adding to the processing available in the mixer/proces-
sors in the system. This is especially useful when a 
variety of loudspeaker types are being used.

Output Source Select
The digital matrix delivers the audio signals used in 
normal operation.  The pink noise source can be used 
for sound masking during operation, and for equaliza-
tion during setup.  The tone generator is used for level 
adjustments and signal routing diagnostics.

Output Signal Processing Stages
Each output channel provides a delay, nine filters, plus 
a compressor and limiter to idealize the channel for 
its function in the sound system.  (See Typical Output 
Signal Processing Block.)

Digital Delay
Delay on the output signal is normally used for time 
alignment when loudspeakers are positioned in different 
locations with overlapping coverage patterns that cause 
comb filtering.  The signal can be delayed up to 200 ms 
in 0.5 ms increments to eliminate comb filtering and 
improve intelligibility.

Filters
Up to nine filters can be implemented at each output to 
idealize the output channel equalization and implement 
crossover networks for bi-amped or tri-amped loud-
speaker systems.

The filter types include: 
 Low pass 
 High pass 
 Band pass 
 Parametric EQ 
 Low shelving 
 High shelving

Filter slopes can be selected with 6 or 12 dB per octave 
Butterworth or Bessel parameters.  Multiple filters can 
be assigned to creater steeper slopes in 6 dB steps.

Compressor
A versatile compressor is provided at each output to 
control the average level and dynamics of the audio sig-
nal, and restrict the maximum output level to optimize 
the channel for its purpose.

Compressor adjustment parameters include: 
 Threshold 
 Time constant 
 Compression ratio 
 Makeup gain

Limiter
A sophisticated limiter with adjustable threshold and 
time constant parameters can be set up for each output, 
which is normally used to protect a loudspeaker system 
and reduce distortion and amplifier overload.

Limiter adjustment parameters include: 
 Threshold 
 Time constant

The limiter implementation is based on an RMS level 
detector controlled by a single time constant parameter. 
This is an adaptive design which responds to vary-
ing rates of change in the signal level by dynamically 
adjusting the attack and release times for best perfor-
mance.

Output Gain and Level Indicator
The level of each output can be adjusted over the full 
range in 1 dB steps. A bar graph is provided in the GUI 
to accurately indicate the output level as it operates. 
See the detailed description on page 26 under the topic 
entitled Gain/Level Tab.

Typical Output Signal Processing Block

Activity Indicator

Output Gain
-70 - +20 dB
1 dB steps

Nine Filter
StagesDelay Compressor Limiter

Level Meter

Off, LP, HP, BP,
PEQ, LS, HS

6 or 12 dB/oct.
Butterworth or Bessel 

when applicable

0 – 200 ms
0.5 ms steps

Threshold
Comp. Ratio

Time Constant

Indicator
Activity Indicator

Gain Reduction Indicator

Threshold
Time Constant

One of 12 Output Signal Processing Blocks
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DMPA12 Controls and Features
Front Panel

USB Ports
Standard USB connectors are provided on front and 
rear panels for setup and control of the DM from a com-
puter using a Windows-based operating system.

MODE Switch
The MODE Switch is used for two purposes:

•	 During	power	up	to	switch	the	unit	temporarily	from	
Slave to Master to enable access with a computer 
to make changes in settings

•	 To	set	the	unit	into	a	Software	Update	mode	for	
updating the firmware

If a unit configured to run in a slave mode doesn’t detect 
a master unit on power up, it will refuse to boot and 
the Status LED will blink rapidly. In this case, pressing 
the MODE switch will force the unit to boot up tempo-
rarily as a master to allow settings to be examined or 
changed. Cycling the power returns the unit to the slave 
mode.

Pressing and holding the MODE switch while power-
ing up the unit places it in Software Update mode. The 
Status LED will blink slowly once a firmware update is 
initiated, then goes out when the process is completed. 
Cycling the power exits the Software Update mode and 
returns the unit to normal operation.

Front Panel Gain Controls
The gain of output audio channels is adjustable with 
control knobs on the front panel of the DMPA12. This 
feature is useful for system setup and adjustment, and 
may be left enabled to allow users to “touch up” gains 
as needed during operation. Gain can be increased or 
decreased within a range which is centered around 0 
dB (unity) gain.

The range of adjustment for each channel is individually 
programmable using the Control Panel GUI (in Device 
Setup Menu) or Lecnet2 serial commands. Changes 
made to the gain range settings take effect immediately 
and are global in scope - the same settings are in effect 
no matter what memory “preset” is loaded. The default 
range is 30 dB (+/- 15 dB). 

Any or all of the front panel gain controls may be 
“locked out” to prevent unauthorized changes to the 
system. This is also done using the Control Panel GUI 
(in Device Setup Menu) or Lecnet2 serial commands. 
Changes made to the gain control lock settings take 
effect immediately and are global in scope - the same 
settings are in effect no matter what memory “preset” is 
loaded.

NOTE:   When the Front Panel Mute feature is 
enabled, the minimum gain position has a special 
meaning. The channel will be muted and the 
associated activity indicator will blink RED to 
warn the user that no audio is being passed. This 
feature can be controlled using the supplied GUI 
control panel or the serial command “fpmten.”

Front Panel Output Activity Indicators
These indicators reflect activity on the output audio 
channels. Useful for setup and troubleshooting, these 
tri-color LEDs are interpreted as follows:

•	 DARK	channel	is	inactive	

•	 GREEN	audio	present	(level	greater	than	-35	
dBu) 

•	 ORANGE	output	compressor	is	active	

•	 RED	output	is	in	limiting	

•	 BLINKING	RED	output	has	been	muted	using	
front panel gain control 

•	 BLINKING	ORANGE	a	fault	exists	on	the	output	
- check wiring for short circuits, etc.

* Windows® Vista is a trademark of Microsoft Corporation

If the STATUS LED 
blinks at turn on, 
press the MODE 
button to change 
it to Master status 

temporarily.
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Rear Panel

POWER Plug
Standard NEMA 5-15 three-pin power plug capable of 
accepting 100-240 VAC, 47-63 Hz.

RS-232 Port
Standard USB connector for setup and control of the 
DM from a computer using a Windows-based operating 
system.

USB Port
Standard USB connector for setup and control of the 
DM from a Windows-based computer system with USB 
interface.

POWER
100-240V  50/60Hz  200W

This device complies with 
Part 15 of the FCC rules. 
Operation is subject to the  
following two conditions: (1)
This device may not cause 
harmful interference, and (2) 
this device must accept any 
interference received, including 
interference that may cause 
undesired operation.

MADE IN U.S.A.

12  CHANNEL  POWER  AMPLIFIER1: GND
2: IN 1
3: IN 3
4: IN 5
5: IN 7

25
13

14
1 6: IN 9

7: IN 11
8: GND
9: OUT 1
10: OUT 3

11: OUT 5
12: OUT 7
13: GND
14: +5V
15: IN 2

16: IN 4
17: IN 6
18: IN 8
19: IN 10
20: +5V

21: OUT 2
22: OUT 4
23: OUT 6
24: OUT 8
25: +5V

PROGRAMMABLE
INPUTS / OUTPUTSRS-232

 LecNet 2 

USB EXPANSION

A BTX RX

RX TX

1 2

 OUTPUT 

3 4 5 6 7 8 9 10 11 12

Programmable Input and Output Ports
Programmable inputs or outputs used to enable control 
over a variety of parameters or to indicate the current 
state of a programmable input or other device settings.

DANI
DANI, or Digital Audio Network Interface, is used to 
connect the digital audio outputs of the master and 
slave units in stacked configurations.

Audio Outputs
Analog audio output connectors. Standard depluggable 
jacks with output pairs sharing a common ground con-
nection in the center of the connector. The outputs are 
a balanced differential type that can be used with or 
without shielded cabling.

* Windows® Vista is a trademark of Microsoft Corp.
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Installing LecNet2™ Software and USB Driver
The LecNet2 USB drivers are installed from the Installa-
tion Disk which comes with each processor by running 
the LecNet2 Device Installer. Normally, this is done 
before connecting a processor for the first time, how-
ever, it can done afterwards if necessary. The driver 
installation only needs to be done once.

If a LecNet device is connected to a PC without prior 
installation of the driver from the Installation Disk, 
manual installation is possible in the cases of Windows 
XP and Vista operating systems using the New Hard-
ware Found wizard. In the case of Windows 7, there is 
no New Hardware Found wizard, so manual installation 
is a bit more involved. In any of these cases, it’s not 
really necessary - just cancel the New Hardware Found 
wizard (if open) and run the LecNet2 Device Installer 
from the Installation Disk.

Installation with LecNet2 Device Installer

Step 1
Place the LecNet2 Installation Disk into the CD-ROM 
drive on the computer. If Auto Run is enabled on that 
drive, the installation utility will open.

If AutoRun is not enabled, use Start>Run to run auto-
Run.exe on the drive holding the LecNet2 Installation 
Disk.

If the CD-ROM drive is assigned as drive E: then type 
E:\autoRun.exe in the window and press Enter to open 
the LecNet2 utility.

With Windows Vista and 7 operating systems, click on 
the Windows logo at the bottom left of the desktop, then 
type E:\autoRun.exe into the search field just above 
the Windows logo.

Two versions of the USB driver installer are provided for 
different types of Windows PC:

•	 32-bit	Windows,	click	on	Install	USB	Drivers	(32-
bit)

•	 63-bit	Windows,	click	on	Install	USB	Drivers	(64-

bit)

Click on the option that is correct for your PC.

Step 2
The LecNet2 Device Installer opens:

Click Next to proceed

Step 3
The EULA is presented:
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Accept, then click Next to proceed.

The drivers are installed from the CD. When installation 
is complete, the final page of the installer will appear.

The Driver Name and Status are displayed. Click on 
Finish to close the installer. You may new connect any 
LecNet2 device to the PC and drivers will be loaded 
automatically.

Manual Installation
If the USB drivers have not been pre-installed on a PC 
prior to connecting a LecNet2 device for the very first 
time, you may install the manually if you wish.

On Windows XP and Vista operating systems, the 
Found New Hardware Wizard will open when the de-
vice is detected. It will walk you through the process of 
installing the LecNet2 drivers. To proceed, you will need 
the LecNet2 Installation Disk. Click on the following link 
and follow the instructions:

Windows XP USB driver manual installation guide

On Windows 7 operating systems, the system attempts 
to find a driver automatically when the device is de-
tected. If it cannot find one, it notifies the user that driver 
installation failed. In this case, the Windows Device 
Manager is used to install the drivers. To proceed, you 
will need the LecNet2 Installation Disk. Follow these 
instructions:

Windows 7 USB driver manual installation guide

http://www.lectrosonics.com/lecnet2/help/usb_drv1.html
http://www.lectrosonics.com/lecnet2/help/usb_drv0.html
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Firmware Updates
Using the Update Wizard

The control panel can be used to download firmware 
updates to the DMPA12. The Update Wizard guides you 
through the steps of the update process. Since a failed 
firmware update can leave the DMPA12 in an unus-
able state, it is important to follow the instructions in the 
Update Wizard exactly. 

NOTE: The update process is possible only using 
a USB connection.

Firmware updates are distributed as a file whose name 
follows the pattern “DMPA12-vX_X_X.update”, where 
the “X_X_X” is a placeholder for a firmware version 
number. For example a firmware update for version 
number “1.1.12” would have the filename “DMPA12-
v1_1_12.update”. The dots normally used to separate 
the three parts of the version number are replaced with 
underscores in the filename for clarity.

Before starting make sure that the proper update file 
is on hand. Connect the DMPA12 to a computer sys-
tem with a USB cable.  Apply power to the DMPA12 
and start the control panel software on the computer 
system.

1. Choose File->Update... from the Control Panel Menu 
Bar to open the Update DMPA12 Firmware Wizard.

2. The first page of the Wizard displays instructions 
for the process of forcing the DMPA12 into update 
mode. Follow them carefully and then click Next to 
move to the SELECT DEVICE FOR UPDATE. 

3. Any LecNet2 device detected on the USB port will 
be listed. Click the DMPA12 unit to be updated. If 
nothing appears on the list, or the unit to be updated 
does not appear, check that the USB cable is con-
nected and click Refresh List.

 Once the DMPA12 is selected, click Next to move to 
SELECT UPDATE FILE.

4. Enter the file name for the update in the Path to Up-
date File field or click the browse button next to the 
filename field to locate the update file.  If the browse 
button is clicked, the Select DMPA12 update file 
dialog opens.  If the file name was entered manually, 
click Next.

If the browse button was clicked, select the update 
file from the list and click Open to transfer that file-
name to the Path to Update File field.

Browse
button
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The entire process will take 15 minutes or so. A 
notification message appears when the update is 
finished.  Follow the instructions in the message to 
verify that the DMPA12 restarts with the updated 
firmware version. 

At this point the process is complete and the Wizard 
will be ready to close. Click OK to dismiss the mes-
sage.

Click Finish to close the Wizard.

You can now connect to the newly updated DMPA12 
with the control panel. The updated firmware ver-
sion number should appear in the status bar.

Then click Next.

5. Click Start Update to begin the firmware update. The 
update is made in two stages, an update of the DM 
DSP firmware, followed by an update of the control-
ler firmware.

The progress bar indicates the status of each up-
date stage.
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Initial Setup
The initial setup of a DMPA12 system is a simple four 
step process:

•	 Set	the	unit	to	the	Master mode, if necessary

•	 Connect the unit to the computer

•	 Select	the	signal	Source using the GUI

•	 Set	the	Gain / Level using the GUI

LecNet2™ Software and the USB Driver must be in-
stalled before these steps can be completed.

Master/Slave Configuration
IMPORTANT:  When operated as a “stand 
alone” unit, the amplifier must be configured 
as a Master before it will communicate with a 
computer for setup.

First, connect ONLY the computer and a power cable 
to the processor. Turn the power on and observe the 
Status LED on the front panel. If the LED is blinking, the 
unit is in the Slave mode and cannot start up because it 
does not detect the presence of a Master unit.

If the STATUS LED blinks at power up, press the MODE 
button to reset the unit temporarily to the Master mode. 
The unit can then be connected to a computer and 
configured as needed for operation.

Permanent changes to the Master/Slave status must 
be made with the GUI interface. The front panel MODE 
button is temporary only.

Connection
For simplicity, the instructions shown on this page 
include only USB and RS-232 connections for setup 
using a computer connected directly to the amplier. For 
additional methods of connecting to the unit including 
network and offline use, see the Installation Guide.

Connect the computer system to the DMPA12 unit us-
ing either the USB cable or the BLACK DB9 to stereo 
mini (TRS 1/8”) cable for RS-232 communications.  
(Both cables are included with the unit.)

NOTE: Only one DMPA12 unit at a time can be 
connected to a serial port using the RS-232 cable. 
Multiple units may be connected to a USB port 
using a USB hub. 

Turn the computer system on.  After the boot sequence 
is complete, click Start, then All Programs.

Select LecNet2, then select the DMPA12 control panel 
from the list.

If the “Just a Reminder” dialog appears, click OK to 
continue.

Click Connect on the Main Menu bar, then select the 
type of connection between the computer system or 
external control system and the DMPA12 unit.

USB - A standard interface that launches automatically 
when the unit is connected and turned on. Front and 
rear USB ports are provided.

Serial->COM1 - An RS-232 port for RS-232 com-
munications between the DMPA12 and the computer 
sytsem, or for connecting the DMPA12 to an external 
Crestron® or AMX® control system.

NOTE: The menu will list all serial ports detected 
on the PC. However, many newer PCs have no 
RS232 serial ports at all, so no serial connection 
options will be listed.

Connecting via a USB port.

The STATUS LED will blink if the 
unit is turned on and in the Slave 
mode and there is no DM Master 

processor connected to it.

Use the GUI 
to make 

permanent 
changes to the 
Master/Slave 

status.
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Activity Tab
The Activity Tab provides an “at a glance” monitoring 
of output levels, when the amplifier is connected to a 
computer system. This dynamic display indicates audio 
signal levels at each output and the state of compressor 
and limiter activity.

DMPA12 System Setup Tabs
Gain set on each channel is indicated in a window next 
to each level meter. Gain can be adjusted by entering 
a number directly into this window or with the vertical 
slider at the right of each bar graph.

Channel Activity/Gain 
LEDs, level meters, slider controls and gain value win-
dows for monitoring and controlling the output channels.

Level Meter 
This is a true RMS level meter which displays the out-
put audio level in dBu after digital signal processing is 
complete. The range of the meter is -40dBu to +20dBu, 
referenced to the internal voltage scale prior to digital 
to analog conversion and power amplification. Note: 
The relationship between output level as indicated on 
the level meter and power output into an 8 ohm load is 
determined by these facts: 

The maximum output of the digital to analog converter 
(DAC) is 1 Vrms. So a full scale (+20 dBu) signal, after 
digital to analog conversion, results in a 1 volt signal at 
the input of the power amplifier. 

The gain of the power amplifier stage is 20dB (for volt-
ages, a tenfold increase).

So a 1 kHz test tone shown by the level meter to have 
a level of +20 dBu (full scale) will result in in a power 
output of 12.5 watts into an 8 ohm resistive load. This is 
because the full scale signal, after conversion, results 
in a 1 volt input to the power amplifier. Since it has a 
gain of 20dB, the power amplifier output is 10 volts, 
developed across the 8 ohm load. From “power equals 
voltage squared divided by resistance” we get 100/8 or 
12.5 watts. A +10 dBu test tone will result in 1.25 watts, 
a 0 dBu test tone will result in 0.125 watts, and so on.

Channel Activity/Gain

MU LED

Level Meter

C/L LEDs

Note: These values are based on “ideal” 
components, including the load resistance. 
Variations in real-world components will result in 
measured power varying by as much as 0.5dB 
from calculated figures.

MU LED 
Glows red when channel is muted.

C/L LEDs 
Glows yellow if the output channel compressor is active, 
or red if the output channel audio is in limiting.
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Back propagated Final Mix signals 
available on pulldown menu

Forward propagated Main Mix 
signals available on pulldown menu

Pink noise and tone generator sources

Source Tab
The controls on this tab allow the selection of a signal 
source for each of the output channels. Normally, the 
channel is fed a forward or back propagated signal from 
either the main matrix or the expansion matrix. The 
DMPA12 also contains two internal test signal genera-
tors that can be used for diagnostics or sound masking 
as alternative signal sources for an output channel:

•	 Final	Mix	signals	back	propagated	from	the	Master	
unit above it in the system stack

•	 Forward	propagated	main	mix	signals	from	the	
Slave unit below it in the system stack

•	 A	pink	noise	source

•	 1	kHz	sine	wave	source.

If connected to a DMPA12, changes made in this tab 
take effect immediately. As always, the changes are not 
permanent unless the DMPA12 settings are stored to a 
preset in nonvolatile memory.

Clicking on the Matrix button displays a pull down to 
reveal all signals available from the main and expansion 
matrices.

Output channel source controls
The output channel signal source is selectable here from 3 choices: 

•	 Matrix 
A signal from the DANI bus is used as the signal source. When the DMPA12 is operated as as a Slave in a multi-
unit system, one of the 12 back propagated final mixes from the main mix matrix should be selected, or one of the 
2 back propagated expansion mixes from the expansion mix matrix. This is the usual case, however, when oper-
ated as the Master in a multi-unit system, the 24 forward propagated main mixes also become available as signal 
sources. In this special case - and only in this case - it can make sense to drive outputs from a forward propagated 
main mix rather than one of the back propagated Final Mixes. 

•	 Pink	Noise 
A 0 dBu pink noise generator is used as the signal source. 

•	 1	kHz	Tone 
A 0 dBu 1kHz sine wave generator is used as the signal source
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Delay Tab
Select the  Delay Tab. Each output channel can be delayed for up to 200 ms, enough for virtually any application.

If connected to a DMPA12, changes made in this tab take effect immediately. As always, the changes are not perma-
nent unless the DMPA12 settings are stored to a preset in nonvolatile memory.

Delay controls
The delay settings for the output channels are displayed here in one of 3 selectable units of measure:

	 •	 Time	in	milliseconds	-	adjustable	from	0	(“Off”)	to	20	ms.	 
•	 Distance	in	feet	-	adjustable	from	0	(“Off”)	to	255.55	ft.	 
•	 Distance	in	meters	-	adjustable	from	0	(“Off”)	to	68.75	m.	

There are two ways to change the delay: 

	 •	 Click	on	the	buttons	next	to	the	control	to	run	the	value	up	or	down 
•	 Type	a	value	directly	into	the	control	and	press	ENTER

The value in the control can be copied and pasted into another channel using CTRL-C to copy, CTRL-V to paste, and 
then pressing ENTER . 

Units select buttons
Select the unit of measure using the radio buttons in this group. The values in the delay controls will be updated im-
mediately if the unit of measure is changed.

Select delay units with these buttons
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Filters Tab
Select the  Filters Tab. A bank of 9 parametric filters 
is available on each output channel, offering unusual 
flexibility in system design. Any or all may be used, and 
can be individually configured as one of 6 different filter 
types. 

This tab contains a notebook of output filter settings, 
with a separate page for each output channel. If con-
nected to a DMPA12, changes made in this tab take 

Filter set notebook
Each output channel has a set of 9 filters that can be 
used as needed. These are contained within the Filter 
set notebook, with one page per filter. The tabs along 
the bottom of the notebook are used to select one of 
the six filters for setup.

To set up one of the output filters, select a filter type 
from the Filter Type list. Once selected, the appropriate 
controls appear set to some default values. The follow-
ing types are available: 

•	 Parametric (PE) filter with adjustable center fre-
quency, boost/cut, and bandwidth parameters. 

•	 Low Shelving (LS) filter with adjustable center 
frequency and boost/cut parameters. Rolloff rate is 
selectable as 6dB or 12dB per octave. 

•	 High Shelving (HS) filter with adjustable center 
frequency and boost/cut parameters. Rolloff rate is 
selectable as 6dB or 12dB per octave. 

•	 Low Pass (LP) filter with adjustable center fre-
quency parameter. Rolloff rate is selectable as 6dB 
or 12dB per octave, and response is selectable as 
Butterworth or Bessel. 

•	 High Pass (HP) filter with adjustable center fre-
quency parameter. Rolloff rate is selectable as 6dB 
or 12dB per octave, and response is selectable as 
Butterworth or Bessel. 

•	 Band Pass (BP) filter with adjustable center fre-
quency and bandwidth parameters. 

effect immediately. As always, the changes are not 
permanent unless the DMPA12 settings are stored to a 
preset in nonvolatile memory.

The tabs along the bottom of the output channels 
notebook are used to select the settings for a particular 
output channel.

Frequency parameters are are adjustable from 20Hz to 
20kHz. Boost/cut parameters are adjustable from -30dB 
to +30dB. Bandwidth parameters are adjustable from 
0.05 to 20.0 octave. In any of the controls displaying 
a numerical value, there are two ways to change the 
value: 

•	 Click	on	the	buttons	next	to	the	control	to	run	the	
value up or down 

•	 Type	a	value	directly	into	the	control	and	press 
ENTER

Changes made to filter parameters will be immediately 
visible on the frequency response graph discussed next. 

Setup parameters for a single filter can be copied and 
pasted into another output filter. There are two ways to 
do this: 

Select the page for the source filter in the Filter set 
notebook, right click on the page and choose Copy 
Filter from the popup menu. Then select the page for 
the destination filter (for the same or a different output 
channel), right click, and choose Paste Filter from the 
popup menu. 

With the source filter page selected, choose Edit->Copy 
Filter from the Menu Bar. Then select the page for the 
destination filter and choose Edit->Paste Filter from the 
Menu Bar.

Select filter type with 
pulldown menu

Blue curve shows 
composite effect of all 

filters applied

Red curve shows current 
filter selected
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Setup parameters for the entire filter set belonging to an 
output channel can be copied and pasted into another 
output channel also. This can save a lot of time when 
multiple output channels need the same filter set. There 
are two ways to do this: 

Right click somewhere outside the Filter set notebook 
and choose Copy Filter Set from the popup menu. Then 
select the page for the destination output channel, right 
click somewhere outside the Filters notebook, and 
choose Paste Filter Set from the popup menu. 

With the source output compressor page selected, 
choose Edit->Copy Filter Set from the Menu Bar. Then 
select the page for the destination output channel and 
choose Edit->Paste Filter Set from the Menu Bar. If you 
wish to paste the copied filter set to ALL output chan-
nels, then choose Edit->Paste Filter Set to ALL from the 
Menu Bar instead.

At times it may be necessary to restore filter settings to 
their default values. To do this right click within the filter 
page and choose Set to default values from the popup 
menu. 

Frequency response graph
Each output channel page contains a graph which dis-
plays two plots: 

•	 The	frequency	response	of	the	currently	selected	
output filter (red line) 

•	 The	total	frequency	response	for	the	output	channel	
(blue line)

The plot for the currently selected filter contains handles 
which can be used as an alternative way to change the 
center frequency, boost/cut, or bandwidth of the filters 
with the mouse. Left click on a handle and move the 
mouse while keeping the left mouse button down until 
the handle is positioned as you like. Release the left 
mouse button and the adjustment is complete. As you 
do this the related numerical control will be updated 
with the exact value corresponding to the position of 
the handle. At all times the impact of changes to the 
currently selected filter on the overall response of the 
channel are visible in the blue plot. Frequency and gain 
are set by a single handle - movement in the horizon-
tal axis controls frequency, movement in the vertical 
axis controls gain. Bandwidth handles move only in the 
horizontal axis. 

The amplitude scale of the graph can be selected as 
one of two ranges, -15 to +15 or -30 to +30 (dB gain) by 
means of the radio buttons below the graph.

Up to nine filters are 
selected with these tabs

Output channels are 
selected with these tabs

Graph scale is selected 
as +/-15 or +/-30 dB
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Compressor Tab
A high quality compressor can be set up to control the 
dynamics of an output signal. This is a “soft” knee type 
with adjustable compression ratio, threshold and time 
constant parameters.The compressor implementation is 
based on an RMS level detector controlled by a single 
time constant parameter. This is an adaptive design 
which responds to varying rates of change in the signal 
level by dynamically adjusting the attack and release 
times for best performance.

Compressor setup
Compressor parameters are set by the following nu-
merical controls:

•	 Threshold	is displayed here and can be adjusted 
from -80dBu to +20dBu. 

• The compressor time constant is displayed here 
and can be adjusted from 0.5 to 1000.0 ms. 

•	 The compression ratio is displayed here and can 
be adjusted from 1:1 (displayed as “Off”) to 50:1 
(displayed as “INF:1”). 

•	 The makeup gain value is displayed here and can 
be adjusted from 0dB to a limit which is a function 
of the threshold and compression ratio. The makeup 
gain value automatically responds to changes to 
the compression ratio so that it never exceeds the 
limit set by the rule:  maximum makeup gain = gain 
reduction at full scale input where the gain reduction 
at full scale input (+20dBu) depends on the thresh-
old and compression ratio selected. 

For any of these controls, there are two ways to change 
the value: 

•	 Click	on	the	buttons	next	to	the	control	to	run	the	
value up or down 

•	 Type	a	value	directly	into	the	control	and	press 
ENTER

This tab contains a notebook of output compressor 
settings, with a separate page for each output channel. 
If connected to a DMPA12, changes made in this tab 
take effect immediately. As always, the changes are not 
permanent unless the DMPA12 settings are stored to a 
preset in nonvolatile memory.

Note to those accustomed to specifying separate 
attack and release time constants:

Select a time constant parameter that is about 
one-half the release time constant you would 
normally choose. Don’t worry about the attack 
time constant, the true RMS detector based 
compressor or limiter will always put into effect 
an optimal value. The greater the rate of increase 
in signal level, the smaller (more aggressive) 
the attack time constant will be. The default time 
constant value is 100 ms, corresponding to a 
release time constant of about 200 ms.

Compressor setup parameters for one output channel 
can be copied and pasted into another output channel. 
There are two ways to do this: 

Right click within the Compressor setup group for the 
source output channel and choose Copy Compres-
sor from the popup menu. Then select the page for the 
destination output channel, right click on Compressor 
setup group, and choose Paste Compressor from the 
popup menu. 

With the source output compressor page selected, 
choose Edit->Copy Compressor from the Menu Bar. 
Then select the page for the destination output channel 
and choose Edit->Paste Compressor from the Menu 
Bar. If you wish to paste the copied compressor settings 
to ALL output channels, then choose Edit->Paste Com-
pressor to ALL from the Menu Bar instead.

At times it may be necessary to restore compressor 
settings to their default values (off, with default time 
constant). To do this right click within the Compressor 
setup group and choose Set to default values from the 
popup menu. 

Values are entered here

Output channels are 
selected with these tabs

LEDs indicate compression and 
limiting for all channels
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Amplitude response graph
Each output channel page contains a graph which dis-
plays four plots:

•	 A	fixed	plot	for	the	1:1	amplitude	response	used	for	
reference (dashed grey line) 

•	 The	amplitude	response	of	the	compressor	(orange	
line) 

•	 The	amplitude	response	of	the	limiter	(dashed	red	
line) 

•	 Total	response,	the	amplitude	response	of	the	com-
pressor and limiter plus makeup gain (blue line)

Three handles are provided for use as an alternative 
way to change the compressor threshold (orange), 
compression ratio (green) and makeup gain (blue) with 
the mouse. Left click on a handle and move the mouse 
while keeping the left mouse button down until the 
handle is positioned as you like. Release the left mouse 
button and the adjustment is complete. As you do this 
the related numerical control will be updated with the 
exact value corresponding to the position of the handle. 
The compressor threshold handle moves along the 
1:1 response diagonal, and the makeup gain and ratio 
handles move along the vertical axis. 

Gain reduction meter
This meter displays the reduction in gain (in dB) that 
results from compressor activity. 

Compressor status indicators
These display the compressor status for all outputs. If 
the compressor for a particular output channel becomes 
active, the corresponding indicator is lit yellow.

Limiter status indicators
These display the limiter status for all outputs. If the 
limiter for a particular output channel becomes active, 
the corresponding indicator is lit red.

1:1 reference 
amplitude response 

(dashed grey)

Limiter threshold (dashed red)

Compressor response 
(dashed orange)

Total response 
(solid blue)
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Gain / Level Tab
If connected to a DMPA12, changes made in this tab 
take effect immediately. As always, the changes are not 
permanent unless the DMPA12 settings are stored to a 
preset in nonvolatile memory.

Besides the main gain setting stored in the DMPA12 
settings, an independent adjustment of output gain is 
possible by using the knobs on the front panel. The 
range of adjustment is variable, with the “12 o’clock” 
position of the gain knob always being the unity gain (0 
dB) setting. The idea is to allow the user to adjust gain 
as needed “on the fly” without modifying the DMPA12 
stored settings using the control panel program.

The total gain on the channel is the sum of the main 
gain setting and the front panel gain setting. 
For instance: 

•	 Main	gain	at	0	dB	plus	front	panel	gain	at	+6	db	
equals 6 dB gain total. 

•	 Main	gain	at	-10	dB	plus	front	panel	gain	at	-8	db	
equals -18 dB gain total.

•	 With	the	front	panel	gain	control	at	the	“12	o’clock”	
position the added gain is 0 dB, or “no effect.”

The output channel gain in dB is displayed and can be 
adjusted from -69dB to +20dB, or set to “Off.” This con-
trol may be referred to as the main output gain control. 
There are two ways to change the gain: 

•	 Click	on	the	buttons	next	to	the	control	to	run	the	
value up or down 

•	 Type	a	value	directly	into	the	control	and	press 
ENTER

The value in the control can be copied and pasted into 
another channel using CTRL-C to copy, CTRL-V to 
paste, and then pressing ENTER .

The controls and indicators for each output channel are 
grouped together. Always visible are the:

•	 Gain	control

•	 Mute	control

•	 Front	Panel	gain	indicator

•	 Level	meter

•	 Compressor/Limiter	status	indicators

A few other settings are available by right clicking on a 
group and choosing them from the popup menu:

•	 Output	channel	label

•	 Gain	control	step	size

•	 Pink	noise	switch

•	 Test	tone	switch

•	 Mute	switch

•	 Phase	invert	switch

•	 Master	output	gain

Mute control
This is a checkbox control which indicates if the output 
is muted (checked) or not (unchecked) for an output 
channel. Simply click on the control to set as desired.

Front Panel gain indicator
The current Front Panel input channel gain in dB is dis-
played here. Monitor this to detect any changes made 
by turning the front panel gain knobs so that the total 
gain for the channel is known. If the Front Panel Mute 
feature is enabled on the channel, and the front panel 
gain knob is in the fully counter-clockwise position, “Off” 
will be displayed.

Front panel (knob) 
gain indicator

Main gain control 
(-69 to +20dB plus “OFF”)

NOTE:  Sum of main gain 
and front panel settings is 
the resulting channel gain

Compressor active

Compressor and 
Limiter active

Mute control 
check box 

(channel muted)
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Level meter
This is a true RMS level meter which displays the out-
put audio level in dBu after digital signal processing is 
complete. The range of the meter is -40dBu to +20dBu, 
referenced to the internal voltage scale prior to digital 
to analog conversion and power amplification. Note: 
The relationship between output level as indicated on 
the level meter and power output into an 8 ohm load is 
determined by these facts: 

The maximum output of the digital to analog converter 
(DAC) is 1 Vrms. So a full scale (+20 dBu) signal, after 
digital to analog conversion, results in a 1 volt signal at 
the input of the power amplifier. 

The gain of the power amplifier stage is 20dB (for volt-
ages, a tenfold increase).

So a 1 kHz test tone shown by the level meter to have 
a level of +20 dBu (full scale) will result in in a power 
output of 12.5 watts into an 8 ohm resistive load. This is 
because the full scale signal, after conversion, results 
in a 1 volt input to the power amplifier. Since it has a 
gain of 20dB, the power amplifier output is 10 volts, 
developed across the 8 ohm load. From “power equals 
voltage squared divided by resistance” we get 100/8 or 
12.5 watts. A +10 dBu test tone will result in 1.25 watts, 
a 0 dBu test tone will result in 0.125 watts, and so on. 
Note: These numbers are based on “ideal” components, 
including the load resistance. Variations in real-world 
components will result in measured power varying by as 
much as 0.5dB from calculated figures.  

Compressor/Limiter status indicators
These display the compressor/limiter status for all out-
puts. If the compressor for a particular output channel 
becomes active, the corresponding indicator is lit yellow. 
If the limiter for that channel becomes active, the indica-
tor is lit red. If a fault is detected on the channel, the 
indicator will blink yellow.

Right Click Options
Right clicking any of the 
channel groups brings up 
options in a popup window.

Output label
Channels may be as-
signed a custom label to 
make it easier to under-
stand a setup. For ex-
ample, labels like Zone 3 
or Cry room might usefully 
replace the default labels Ch 1, Ch 2, etc. To do this, 
right click on the channel group desired and choose 
Output Label... from popup menu. This opens the Edit 
Label dialog: 

Simply type in the new label and press OK. 

Output	gain	step	size
The default step size when using the buttons to run the 
gain up and down is 1dB. To change this right click on 
the channel group desired and choose Output gain step 
size... from the popup menu. This opens the Set Gain 
Step Size dialog: 

Simply select a new step size and press OK. 

Pink Noise On
The pink noise generator can be turned on/off by right 
clicking on the channel group desired and choosing 
Pink Noise On to toggle the switch. If the pink noise 
generator is on, the Pink Noise On menu item will be 
checked, otherwise it is unchecked. This option will be 
disabled if the test tone generator is turned on for the 
output channel.

Test Tone On
The 1 kHz test tone generator can be turned on/off by 
right clicking on the channel group desired and choos-
ing Test Tone On to toggle the switch. If the test tone 
generator is on, the Test Tone On menu item will be 
checked, otherwise it is unchecked. This option will be 
disabled if the pink noise generator is turned on for the 
output channel.

Mute Output
The output channel can be muted/unmuted by right 
clicking on the channel group desired and choosing 
Mute Output to toggle the mute state. If the channel is 
muted, the Mute Output menu item will be checked, 
otherwise it is unchecked. The mute control will change 
state to confirm the action.

Invert Phase
The phase (polarity) of the output channel can be 
changed by right clicking on the channel group desired 
and choosing Invert Phase to toggle the phase invert 
state. If the phase is inverted, the Invert Phase menu 
item will be checked, otherwise it is unchecked. This 
feature is useful to correct for reversals of wiring be-
tween the output connector and an installed speaker.

Master Output Gain
The gain controls for the output channels may be 
ganged together so that a single master control can be 
used to run them up and down. To do this, right click on 
the on any channel group and choose Master Output 
Gain... from popup menu. This opens the Master Output 
Gain Control dialog: 

Simply select which output channels you wish to control 
and then adjust the gain with the buttons provided. Click 
OK when done, the changes made using the master 
gain control will remain in effect after the dialog is 
closed.
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Limiter Tab
The limiter implementation is based on an RMS level 
detector controlled by a single time constant param-
eter. This is an adaptive design which responds to 
varying rates of change in the signal level by dynami-
cally adjusting the attack and release times for best 
performance. 

Note to those accustomed to specifying 
separate attack and release time constants: 
Select a time constant parameter that is about 
one-half the release time constant you would 
normally choose. Don’t worry about the attack 
time constant, the true RMS detector based 
compressor or limiter will always put into effect 
an optimal value. The greater the rate of increase 
in signal level, the smaller (more aggressive) 
the attack time constant will be. The default time 
constant value is 100 ms, corresponding to a 
release time constant of about 200 ms.

This tab contains a notebook of output limiter settings, 
with a separate page for each output channel. If con-
nected to a DMPA12, changes made in this tab take 
effect immediately. As always, the changes are not 
permanent unless the DMPA12 settings are stored to a 
preset in nonvolatile memory.

The tabs along the bottom of the output channels 
notebook are used to select the settings for a particular 
output channel. On each page the following controls 
and indicators are always visible:

•	 Limiter	setup

•	 Amplitude	response	graph

•	 Gain	reduction	meter

•	 Compressor	status	indicators

•	 Limiter	status	indicators

Limiter setup
Limiter parameters are set by the following numerical 
controls:

•	 Threshold 
The limiter input level threshold is displayed here 
and can be adjusted from -80dBu to +20dBu. 

•	 Time Constant 
The limiter time constant is displayed here and can 
be adjusted from 0.1 to 500.0 ms. 

For any of these controls, there are two ways to change 
the value: 

Click on the buttons next to the control to run the value 
up or down 

Type a value directly into the control and press ENTER

Limiter setup parameters for one output channel can be 
copied and pasted into another output channel. There 
are two ways to do this:

Right click within the Limiter setup group for the source 
output channel and choose Copy Limiter from the 
popup menu. Then select the page for the destination 
output channel, right click on Limiter setup group, and 
choose Paste Limiter from the popup menu. 

With the source output limiter page selected, choose 
Edit->Copy Limiter from the Menu Bar. Then select the 
page for the destination output channel and choose 
Edit->Paste Limiter from the Menu Bar. If you wish to 
paste the copied limiter settings to ALL output chan-
nels, then choose Edit->Paste Limiter to ALL from the 
Menu Bar instead.

Compressor activity

Limiter activity

Threshold value

Time Constant

Reference amplitude 
response (dashed grey)

Compressor amplitude 
response (orange line)

Limiter threshold 
(dashed red)

Total amplitude 
response (solid blue)
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At times it may be necessary to restore limiter settings 
to their default values (+15dBu threshold, with default 
time constant). To do this right click within the Limiter 
setup group and choose Set to default values from the 
popup menu. 

Amplitude response graph
Each output channel page contains a graph which dis-
plays four plots:

•	 A	fixed	plot	for	the	1:1	amplitude	response	used	for	
reference (dashed grey line) 

•	 The	amplitude	response	of	the	compressor 
(orange line) 

•	 The	amplitude	response	of	the	limiter 
(dashed red line) 

•	 Total	response,	the	amplitude	response	of	the	com-
pressor and limiter plus makeup gain (blue line)

A handle is provided for use as an alternative way to 
change the limiter threshold (red) with the mouse. Left 
click on a handle and move the mouse while keeping 
the left mouse button down until the handle is posi-
tioned as you like. Release the left mouse button and 
the adjustment is complete. As you do this the related 
numerical control will be updated with the exact value 
corresponding to the position of the handle. The limiter 
threshold handle moves along the vertical axis. 

Gain reduction meter
This meter displays the reduction in gain (in dB) that 
results from limiter activity. 

Compressor status indicators
These display the compressor status for all outputs. If 
the compressor for a particular output channel becomes 
active, the corresponding indicator is lit yellow.

Limiter status indicators
These display the limiter status for all outputs. If the 
limiter for a particular output channel becomes active, 
the corresponding indicator is lit red.
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Programmable inputs notebook
Settings for the 11 programmable inputs are contained 
within a notebook, with one page per programmable 
input. The tabs along the bottom of the notebook are 
used to select one of the programmable inputs for 
setup.

To set up one of the programmable inputs, select a 
function type from the Function list. Once selected, 
controls appear which are used to choose the specific 
feature or features of the DMPA12 that the function ap-
plies to. These choices will vary according to the nature 
of the programmable input function values. The follow-
ing function types are available:

Rear Panel Control Tab
The DMPA12 has 11 programmable inputs which can 
be used to control a wide variety of DMPA12 functions. 
Depending on the function assigned to them, these in-
puts may be connected to momentary contact switches, 
toggle switches, or potentiometers. When used with a 
switch, the inputs are activated by by connecting them 
to ground through the switch contacts, called a “contact 
closure”. When used with a potentiometer, the inputs 
respond to the applied voltage, in the range 0 to 5 VDC.

Another feature of the rear panel control interface are 
a set of 8 programmable outputs which can be set up 
to monitor power amplifier fault status, programmable 
input status, or whether or not particular presets are 
active. Normally, a programmable output is inactive un-
less the specified conditions are fulfilled, at which time it 
becomes active. However, a programmable output can 
be inverted so that the reverse is true - becoming active 
whenever the specified conditions are not fulfilled, and 
vice versa. Programmable outputs act as an electronic 
“contact closure” to ground. When the output is active, 
the contacts are closed (conducting to ground), when 
inactive they are open. 

An important application of the rear panel control inter-
face is to manage what is called the rear panel gain for 
audio output channels. This is an additional gain value 
that is added to the “main” gain value for a channel to 
give the total gain applied. Rear panel gain may be 
adjusted over the range -60dB to 0dB, or set to “Off” 
to silence the channel. It is intended to function as a 
variable attenuator for the audio channel. The purpose 
is to allow some amount of gain or level control by the 
end user in a safe manner, using one of the program-
mable inputs. A typical application of rear panel gain is 
to allow adjustment of the level of an output (driving a 
speaker) downward from some maximum by means of 
turning a potentiometer connected to a programmable 
input which has been set up to use the Analog Output 
RP Gain Control function described below. 

This tab contains a notebook with two pages, one for 
programmable input setup and one for programmable 
output setup. If connected to a DMPA12, changes 
made in this tab take effect immediately. As always, the 
changes are not permanent unless the DMPA12 set-
tings are stored to a preset in nonvolatile memory.

The rear panel control settings (ALL of them, as a 
group) can be copied and pasted into another preset

Analog Output RP Gain Control (AO) 
This function controls the rear panel gain of one or 
more audio outputs in response to changes in voltage 
applied to the programmable input. Normally this func-
tion is used by connecting the wiper of a potentiometer 
to the programmable input so that it acts as a “volume 
control” for the audio output channels that the function 
applies to. The voltage may vary from 0 to 5 VDC. The 
range over which the gain of the audio output channels 
is allowed to vary is controlled by the Rear panel output 
gain controls described below. This function can be ap-
plied to any combination of audio output channels. 

Min gain value

Gain preset value

Rear Panel Gain 
(read only indicators)

Programmable Inputs 
Notebook pulldown
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Inc Output RP Gain 1dB (IO) 
This function increments the rear panel gain of one or 
more audio outputs in response to a contact closure. 
This is normally used with a momentary contact switch. 
The range over which the gain of the audio output chan-
nels is allowed to vary is controlled by the Rear panel 
output gain controls described below. This function can 
be applied to any combination of audio output channels. 

Dec Output RP Gain 1dB (DO) 
This function decrements the rear panel gain of one or 
more audio outputs in response to a contact closure. 
This is normally used with a momentary contact switch. 
The range over which the gain of the audio output chan-
nels is allowed to vary is controlled by the Rear panel 
output gain controls described below. This function can 
be applied to any combination of audio output channels. 

Recall Memory Preset (MP) 
This function initiates the loading of a memory preset 
in response to a contact closure. This is normally used 
with a momentary contact switch, and can be applied to 
any one of the memory presets stored in the DMPA12 
memory. 

Toggle Mute Outputs (MO) 
This function toggles the mute status of one or more 
audio outputs in response to a contact closure. If muted, 
a contact closure unmutes the channel, and vice versa. 
This is normally used with a momentary contact switch, 
and can be applied to any combination of audio output 
channels. 

Momentary Mute Outputs (MMO) 
This function momentarily mutes one or more audio 
outputs in response to a contact closure. The channel is 
muted when the contact closure is made, and unmuted 
when it is broken. Normally used with a momentary 
contact switch, either a “push to mute” or a “push to 
talk” action can be supported (depending on whether a 
normally open or normally closed switch is used). This 
function can be applied to any combination of audio 
output channels. 

Run a Macro on Close (RM) 
This function initiates the running of a macro in re-
sponse to a contact closure. This is normally used with 
a momentary contact switch, and can be applied to any 
one of the macros stored in the DMPA12 memory. 

Run a Macro on Close/Open (RM2) 
This function initiates the running of a macro in re-
sponse to a contact closure, and another macro in 
response to the subsequent contact opening. This is 
normally used with a momentary contact switch, and 
can be applied to any two of the macros stored in the 
DMPA12 memory. 

When certain functions have been selected and the 
control panel is connected to a DMPA12, the Test but-
ton is enabled. Pressing this button simulates a contact 
closure on the programmable input and is very useful 
for testing the function. 

Programmable input status indicators
These display the status of the corresponding program-
mable input when a function has been assigned and the 
control panel is connected to a DMPA12. For the Analog 
Gain Control function, the indicator is lit red when the 
voltage applied to the input is in the upper half of the 
allowable 0 to 5VDC range. For all other functions, the 
indicator is lit red when a contact closure occurs.

Rear panel output gain controls
These are used to set up rear panel gain control for out-
put channels. This operates as an attenuator, adjustable 
from some minimum gain (max attenuation) up to 0dB 
(no attenuation). The group consists of these numerical 
controls and indicators:

•	 Min Gain (minimum gain) 
The minimum gain value establishes the bottom end 
of the rear panel gain control range. The mimimum 
gain value is displayed here and can be adjusted 
from “Off” up to the gain preset value. This value 
tracks the gain preset value and is automatically 
adjusted as required to satisfy the rule: 

 minimum gain <= gain preset

 There are two ways to change the value: 

1) Click on the buttons next to the control to run the 
value up or down

2) Type a value directly into the control and press 
ENTER

•	 Gain Preset 
The gain preset value establishes the starting point 
for rear panel gain control on system powerup. This 
normally used to select a gain point somewhere in 
the middle of the adjustment range. The user may 
then adjust gain up or down from there.

 The value may be changed in the same manner as 
the Gain Preset control.

•	 Rear Panel Gain 
these read-only indicators display the current rear 
panel gain setting (in dB) for each audio output 
channel. These are useful for monitoring the effects 
of rear panel control actions.
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Programmable outputs notebook
Settings for the 8 programmable outputs are contained 
within a notebook, with one page per programmable 
output. The tabs along the bottom of the notebook are 
used to select one of the programmable outputs for 
setup.

To set up one of the programmable outputs, select a 
function type from the Function list. Once selected, 
controls appear which are used to choose the specific 
feature or features of the DMPA12 that the function ap-
plies to. These choices will vary according to the nature 
of the programmable output function values. The follow-
ing function types are available:

Monitor Prog Input State (IS) 
This function monitors a programmable input. The 
response varies according to the function type selected 
for the programmable input. Programmable input func-
tions are as follows: 

Analog Output RP Gain Control 
Active when the gain is in the upper half of range. 
Inc Output RP Gain 1dB 
Active when there is a contact closure on 
programmable input. 
Dec Output RP Gain 1dB 
Active when there is a contact closure on 
programmable input. 
Recall Memory Preset 
Active when the preset controlled by the 
programmable input is the current preset. 
Toggle Mute Outputs 
Active when the audio outputs controlled by the 
programmable input are unmuted. 
Momentary Mute Outputs 
Active when the audio outputs controlled by the 
programmable input are unmuted. 
Run a Macro on Close 
Active when there is a contact closure on 
programmable input. 
Run a Macro on Close/Open 
Active when there is a contact closure on 
programmable input.

Monitor Active Preset (AP) 
This function monitors the active preset and activates 
the programmable output if one of the specified presets 
becomes active (is recalled from nonvolatile memory). 
This function is configured by selecting one or more 
presets to be monitored. 

Monitor Output Faults (OF) 
This function monitors the output power amplifier status 
and activates the programmable output if a fault condi-
tion is detected. This function is configured by selecting 
one or more output channel PAIRS to be monitored. A 
fault on one, the other, or both channels in the pair will 
cause the programmable output to activate. 

To finish the setup, the programmable output invert sta-
tus may be set using the Invert checkbox. If inverted, a 
programmable output will behave in a manner opposite 
to that described above in the function descriptions.

Programmable output status indicators
These are lit red when the corresponding programma-
ble output becomes active (conducting to ground).

Rear Panel Ctrl Copy/Paste
The entire group of rear panel control settings can be 
copied and pasted into another preset. This can save a 
lot of time when a common rear panel setup needs to 
be duplicated in multiple presets. There are two ways to 
do this:

•	 Right	click	somewhere	outside	the	programmable	
inputs/outputs notebook and choose Copy ALL 
Rear Panel Ctrl Settings from the popup menu. 
Then load the destination preset from file (or recall it 
from device memory), right click somewhere outside 
the programmable inputs/outputs notebook, and 
choose Paste ALL Rear Panel Ctrl Settings from the 
popup menu. 

•	 Choose	Edit->Copy	ALL	Rear	Panel	Ctrl	Settings	
from the Menu Bar. Then load the destination preset 
from file (or recall it from device memory), and 
choose Edit->Paste Rear Panel Ctrl Settings from 
the Menu Bar.
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Programmable Outputs 
Notebook pulldown

Invert Status 
Checkbox

Programmable Input 
Selection

Programmable Output 
Status Indicators
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Setting the Front Panel Gain Control Mute Status
Choose Device Setup->Front Panel Gain Control Mute 
from the Menu Bar. The Front Panel Gain Control Mute 
dialog will open:

Use the mouse to enable (or disable) front panel mute 
for the channel of interest. “Checking” a box enables the 
feature. The change will take effect immediately.

Locking the Front Panel gain controls
Choose Device Setup->Front Panel Gain Control Lock 
from the Menu Bar. The Front Panel Gain Control Lock 
dialog will open:

Use the mouse to lock (or unlock) the channel of inter-
est. “Checking” a box locks the associated channel. The 
change will take effect immediately.

DMPA12 Menus and Functions
Setting up Front Panel controls

The gain of output audio channels is adjustable from 
the front panel of the DMPA12. This feature is useful for 
system setup and adjustment, and may be left enabled 
to allow users to “touch up” gains as needed during 
operation.

Gain can be increased or decreased within a range 
which is centered around 0 dB (unity) gain. The range 
of adjustment for each channel is individually program-
mable with the default being 30 dB (+/- 15 dB).

When the Front Panel Mute feature is enabled for a 
channel, the minimum gain position has a special 
meaning - the channel will be muted when the control is 
rotated to the fully counter-clockwise position, and the 
associated front panel indicator will blink RED to warn 
the user that no audio is being passed. 

Any or all of the front panel gain controls may be 
“locked out” to prevent unauthorized changes to the 
system. 

Note: Changes made to gain control range, mute 
and lock settings take effect immediately and are 
global in scope - the same settings are in effect no 
matter what memory “preset” is active. 

Setting the Front Panel gain control range
Choose Device Setup->Front Panel Gain Control Range 
from the Menu Bar. The Front Panel Gain Control 
Range dialog will open:

Use the mouse to select the desired range (in dB) for 
the channel of interest. The change will take effect im-
mediately.
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Editing Output labels
Output channels may be assigned a custom label to 
make it easier to understand a complex setup. For 
example, labels like Zone 1 or “Hallway” might usefully 
replace the default labels Ch 1, Ch 2, etc on output 
channels. Channel labels are limited to 15 characters in 
length.

Changes made to labels are not permanent unless the 
DMPA12 settings are stored to a preset in nonvolatile 
memory.

To edit labels for the audio output channels, choose 
Labels->Outputs... from the Menu Bar. The Edit Output 
Channel Labels dialog will open:

Make changes as desired and press OK to store them.

Setting the Expansion Mode
When installed in a system of one or more DM series 
automixers, the DMPA12 must be configured to operate 
in Slave mode. However in Slave mode a Lecnet2 de-
vice cannot function as a standalone unit, unconnected 
to a system containing a Master device. For this reason 
the DMPA12 ships from the factory with the expan-
sion mode set to Master so that it can be operated in a 
standalone manner. In this configuration it will capable 
of booting up normally so that it can be configured us-
ing the control panel program. Once configured, it will 
need to be switched to Slave mode prior to installation 
in the Lecnet2 system.

If inadvertently set to operate in Slave mode while being 
operated in a standalone manner, the DMPA12 will fail 
to boot up, so it is impossible to connect to it with the 
control panel in order to reverse the change. Recovery 
from this situation is simple. Pressing the recessed but-
ton on the front panel of the DMPA12 will temporarily 
set the expansion mode to Master, allowing it to boot 
up. At this point the DMPA12 can be set back to Master 
mode using the control panel program if desired. 

Expansion mode changes do not take effect until power 
is cycled on the DMPA12.

Of course, once configured as a Slave and installed into 
a system, the DMPA12 boots up normally since it de-
tects the presence of the Master device in the Lecnet2 
system.

Choose Device Setup->Expansion Mode from the Menu 
Bar. A submenu of choices will open, with a check mark 
next to the current value. Use the mouse to select the 
desired expansion mode. The change will not take effect 
until power is cycled on the DMPA12.

Setting the RS-232 Baud Rate
The RS232 serial port on the DMPA12 is intended for 
use with third party control systems. Since the serial 
port capabilities of these systems varies, a means of 
changing the baud rate of the RS232 port to match the 
control system requirement is provided. This adjustment 
affects only the RS232 port.

Choose Device Setup->RS232 Port Baud Rate from the 
Menu Bar. A submenu of baud rate choices will open, 
with a check mark next to the current value. Use the 
mouse to select the desired baud rate. The change will 
take effect immediately.

Managing Presets
24 preset configurations can be stored in the DMPA12 
and recalled with logic input switches or serial com-
mands. Complete information is available in the Help 
files provided in the supplied software.

Managing Macros
Macros add powerful functionality to controlling the 
DMPA12, Complete information regarding the language 
and its use is provided in the Help files.

Finding Help
Simply click on the Help menu item in the upper right 
part of the control panel screen to open the utility.
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DMPA12 Serial Interface and General Commands
DMPA12 General Commands

Command Description

actpre Active preset number 

baud Serial port baud rate 

default Set a memory preset to factory defaults 

defpre Location of the memory preset recalled 
 on powerup

desc Device description string

fplock Front Panel control lock 

fpgnran Front Panel control gain range 

fpmten Front Panel mute enable 

fpmuted Front Panel mute status 

id Device id string 

macro Macro command 

macroti Macro title 

mode Master/Slave mode 

predesc Preset description 

premsk Default preset mask 

rank Rank of device in group of connected 
 devices

recall Recall a memory preset 

run Run a macro

seq Startup sequence number

serial Device serial number string 

sleep Suspend macro execution 

store Store settings to a memory preset 
 location 

version Device firmware version 

Termination: all commands are terminated with an 
ASCII carriage return character (hex code 0x0D), rep-
resented by <CR> in the examples below. All responses 
are terminated with an ASCII carriage return, line feed 
pair (hex codes 0x0D, 0x0A), represented by <CRLF> 
in the examples below. An ellipsis (...) represents 
members of an array that have been omitted from an 
example for the sake of brevity. 

Verbose response: commands prefixed with an ex-
clamation point (bang) character result in a “verbose” 
response containing the name of the property or ac-
tion being addressed, along with the current values of 
the property in question. Property values are always 
returned in the “assignment” form, for example out-
mt(2)=1. This supports certain 3rd party control pro-
gramming styles where the response to all responses 
needs to be self-describing and/or contain current 

property values.

Examples: 

  REQUEST RESPONSE

 COMMAND !store(3)<CR> OK store(3)<CRLF>

 COMMAND !run={1,3,5}<CR> OK run={1,3,5}<CRLF>

 QUERY !outgn(3)?<CR> OK outgn(3)=0<CRLF>

 QUERY !outmt(*)?<CR> OK outmt(*)={0,1,1,...,0,0,0} 
  <CRLF>

 UPDATE !outgn(3)=0<CR> OK outgn(3)=0<CRLF>

 UPDATE !outmt(*)={0,1,1,..., 
 0,0,0}<CR> OK outmt(*)={0,1,1,...,0,0,0} 
  <CRLF>

actpre (active preset)
This command may be used as a query to determine 
which memory preset is active (that is to say, which 
preset was last recalled from memory). The data is 
an integer type in the range 1 to 12. The active preset 
value may not be assigned directly, use the recall com-
mand instead.

Example:

  REQUEST RESPONSE

 QUERY actpre?<CR> OK 12<CRLF>

baud (baud rate)
This command may be used as a query to determine 
the baud rate setting for the serial port. It may also be 
used as an update to set the baud rate. The data is an 
integer type. The following values are allowed:

•	 9600

•	 19200

•	 38400

•	 57600

•	 115200

Examples:

 REQUEST RESPONSE

 QUERY baud?<CR> OK 57600<CRLF>

 UPDATE baud=57600<CR> OK<CRLF>

default (default settings)
This command may be used to restore a memory 
preset to the factory defaults. The preset location to 
be modified is specified by using the address syntax. 
Addresses must be in the range 1 to 24. No data is 
transferred.

Example:

 REQUEST RESPONSE

 COMMAND default(3)<CR> OK<CRLF>
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 defpre (default preset)
This command may be used as a query to determine 
the memory preset location used as the powerup de-
fault. It may also be used as an update to set the default 
preset. The data is an integer type in the range 0 to 
24, where 0 has the special meaning “On powerup, the 
preset that was active when the unit was last powered 
down will be recalled”.  This provides a “memory” capa-
bility useful for some applications, and is called the Last 
Preset  option.

Examples:

  REQUEST RESPONSE

 QUERY defpre?<CR> OK 11<CRLF>

 UPDATE defpre=2<CR> OK<CRLF>

desc (description)
This command may be used as a query to read the 
user defined device description. It may also be used as 
an update to set the description. The data is a string 
type, with a limit of 32 characters.

Note: String arguments in commands need to be 
passed in quoted form, contained in a pair of double-
quote (“) characters. A problem arises when using the 
desc command to read or write a string that already 
contains double-quote characters, for example: The 
“Hula” Room. The solution is to escape the double 
quotes within The “Hula” Room so that it can be passed 
as a string argument for the desc command. This is 
done by preceding the double-quote characters with a 
backslash character like this: The \”Hula\” Room. Now it 
can be passed as a string argument to the desc com-
mand: desc=”The \”Hula\” Room”. Since the backslash 
serves as the escape character in quoted-string argu-
ments, it too must be escaped if it is part of the string, 
so “foo\bar” would become “foo\\bar” 

Examples:

 REQUEST RESPONSE

 QUERY desc?<CR> OK “Aloha Room East”<CRLF>

 UPDATE desc=”Courtroom 
 #12”<CR> OK<CRLF>

id (device id)
This command may be used as a query to read the 
device id string. This is the “name” of the device used by 
the Lecnet2 protocol and is always “DMPA12”. The data 
is a string type.

Example:

 REQUEST RESPONSE

 QUERY id?<CR> OK “DMPA12”<CRLF>

 macro (macro command)
This command may be used as a query to read one 
command from a macro, or as an update to set a com-
mand. The command is specified by using the 2 dimen-
sional address syntax. Addresses for the first dimension 
specify the macro and must be in the range 1 to 128. 
Addresses for the second dimension specify the index 
of the command within the macro and must be in the 
range 1 to 64. The data type is string, with a limit of 110 
characters.

Note: String arguments in commands need to 
be passed in quoted form, contained in a pair of 
double-quote (“) characters. A problem arises 
when using the macro command to read or write a 
Lecnet2 command that already contains double-
quote characters, for example the command 
desc=”whatever”, which contains the quoted string 
argument “whatever”. The solution is to escape 
the double quotes within desc=”whatever” so that 
it can itself be passed as a string argument for 
the macro command. This is done by preceding 
the double-quote characters with a backslash 
character like this: desc=\”whatever\”. Now it can 
be passed as a string argument to the macro 
command: macro(1,1)=”desc=\”whatever\””. Since 
the backslash serves as the escape character in 
quoted-string arguments, it too must be escaped 
if it is part of the string, so “foo\bar” would become 
“foo\\bar.” 

Examples:

 REQUEST RESPONSE

 QUERY macro(1,3)?<CR> OK “outgn(3)=5”<CRLF>

 QUERY macro(1,3)?<CR> OK “desc=\”embedded string 
  ””<CRLF>

 UPDATE macro(12,50)= 
 ”outmt(2)=1”<CR> OK<CRLF>

 UPDATE macro(12,50)= 
 ”desc=\”embedded 
  string\””<CR> OK<CRLF>



Reference Manual

Rio Rancho, NM 37

 macroti (macro title)
This command may be used as a query to read the title 
of a macro, or as an update to set the title. The macro is 
specified by using the address syntax. Addresses must 
be in the range 1 to 128. The data type is string, with a 
limit of 30 characters.

Note: String arguments in commands need to 
be passed in quoted form, contained in a pair of 
double-quote (“) characters. A problem arises 
when using the macroti command to read or 
write a string that already contains double-quote 
characters, for example: The “Hula” Room. The 
solution is to escape the double quotes within The 
“Hula” Room so that it can be passed as a string 
argument for the macroti command. This is done 
by preceding the double-quote characters with a 
backslash character like this: The \”Hula\” Room. 
Now it can be passed as a string argument to 
the macroti command: macroti(1,1)=”The \”Hula\” 
Room”. Since the backslash serves as the escape 
character in quoted-string arguments, it too must 
be escaped if it is part of the string, so “foo\bar” 
would become “foo\\bar.” 

Examples:

 REQUEST RESPONSE

 QUERY macroti(1)?<CR> OK “Sidebar nbr 2”<CRLF>

 UPDATE macroti(12)= 
 ”Setup #3 West” 
 <CR> OK<CRLF>

 mode (Master/Slave mode)
This command may be used as a query to determine 
if the DMPA12 is operating as a Master or as a Slave. 
It may also be used as an update to set the mode. 
Updates do not take effect until power is cycled on the 
device. The data type is integer, either “1” meaning 
Master mode, or “0” meaning Slave mode. 

Examples:

 REQUEST RESPONSE

 QUERY mode?<CR> OK 0<CRLF>

UPDATE mode=0<CR> OK<CRLF>

 predesc (preset description)
This command may be used as a query to read the 
user defined preset description. It may also be used as 
an update to set the description. The data is a string 
type, with a limit of 60 characters.

Note: String arguments in commands need to 
be passed in quoted form, contained in a pair of 
double-quote (“) characters. A problem arises 
when using the desc command to read or write 
a string that already contains double-quote 
characters, for example: The “Basic” setup. The 
solution is to escape the double quotes within The 
“Basic” setup so that it can be passed as a string 
argument for the desc command. This is done 
by preceding the double-quote characters with a 
backslash character like this: The \”Basic\” setup. 
Now it can be passed as a string argument to the 

desc command: desc=”The \”Basic\” setup”. Since 
the backslash serves as the escape character in 
quoted-string arguments, it too must be escaped 
if it is part of the string, so “foo\bar” would become 
“foo\\bar.” 

Examples:

 REQUEST RESPONSE

QUERY predesc?<CR> OK “Wedding #1, no hallway 
   speakers”<CRLF>

 UPDATE predesc=”Weekly Rotary 
 Club breakfast 
  meeting.”<CR> OK<CRLF>

 premsk (default preset mask)
This command may be used as a query to determine 
the default preset mask in effect. It may also be used as 
an update to set the default mask. The preset mask is a 
number which determines whether or not certain mute 
and rear panel gain settings are preserved or overwrit-
ten when a preset recall occurs. The default mask is in 
effect unless overridden by the recall command. The 
data is an integer type formed by adding together one 
or more of the following values:

•	 4  to preserve output channel rear panel 
gain settings

•	 8  to preserve output channel mute settings

•	 16  to preserve the state of programmable inputs

•	 32  to preserve programmable input function 
definitions

For instance, to preserve output mutes and the state of 
programmable inputs on preset recalls, but not the rear 
panel gains, the mask value would be calculated as 8 
+ 16 = 24. A value of 0 means that the preset recall is 
“hard,” with all mutes and rear panel gains overwritten 
by the values contained in the newly active preset.

Examples:

 REQUEST RESPONSE

 QUERY premsk?<CR> OK 8<CRLF>

 UPDATE premsk=16<CR> OK<CRLF>

rank (rank in Lecnet2 chain)
This command may be used as a query to determine 
the rank of the unit within a chain in interconnected 
Lecnet2 devices. For instance, in a group of 3 devices, 
the “top” or “master” unit will be considered to have rank 
“1 of 3”, while the last unit in the chain will have rank “3 
of 3”. The data type is array of integer, of size two. The 
first value indicates the position of the unit, the second 
indicates the number of devices in the chain.

Example:

 REQUEST RESPONSE

QUERY rank?<CR> OK {1,2}<CRLF>
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 recall (recall preset)
This command may be used to recall a memory pre-
set, making it the active preset. The preset location to 
be recalled is specified by using the address syntax. 
Addresses must be in the range 1 to 24. If used as a 
simple command, no data is transferred, and the preset 
recall is controlled by the default preset mask. If used 
as an update, the data type is an integer whose value 
serves as the preset mask for the recall operation, over-
riding the default preset mask. See premsk.

Example:

 REQUEST RESPONSE

 COMMAND recall(3)<CR> OK<CRLF>

 UPDATE recall(4)=1<CR> OK<CRLF>

run (run a macro)
This command may be used to run a macro (an inter-
nally stored group of DMPA12 commands). A single 
macro may be run by using the command form. In 
this case the macro is specified by using the address 
syntax. Addresses must be in the range 1 to 128. More 
than one macro may be run with a single command by 
using the update form. In this case the data type is ar-
ray of integer, with a variable length in the range 1 - 16. 
The values contained in the array specify which macros 
to run. 

Example:

 REQUEST RESPONSE

COMMAND run(3)<CR> OK<CRLF>

 UPDATE run={1,3,5}<CR> OK<CRLF>

seq (startup sequence number)
This command may be used as a query to determine 
the startup sequence number. It may also be used as 
an update to set the mode. The data type is integer, in 
the range 1 to 15. The default is 1. This number can be 
used to control the startup sequence of slave units in 
a multi-unit system. It has no effect on units configured 
as the system master. After powerup, a slave device 
will delay program start for a time set by the sequence 
number, in multiples of 2 seconds. For example in a 
system with 3 units, “seq” could be set to 1 for the 1st 
slave device, and to 2 for the 2nd. In this case the 1st 
slave will start running 2 seconds after the master unit, 
and the 2nd slave will start running 2 seconds after that 
(4 seconds from powerup). This ensures that the units 
in the system will come up in a time-sequenced way if 
the system or equipment rack is powered up all at once. 
This ensures a smooth startup for the inter-connecting 
DANI bus. 

Examples:

  REQUEST RESPONSE

QUERY seq?<CR> OK 1<CRLF>

UPDATE seq=2<CR>  OK<CRLF>

serial (serial number)
This command may be used as a query to read the 
device serial number. The data is a string type.

Example:

 REQUEST RESPONSE

 QUERY serial?<CR> OK “1234”<CRLF>

sleep (suspend macro execution)
This command may be used as an update to suspend 
the execution of commands withing a macro for a fixed 
period of time specified in milliseconds. The data is an 
integer type in the range 0 to 30000.   This allows the 
the timing of a series of actions performed by a macro 
to be controlled.  option.

Examples:

 REQUEST RESPONSE

 UPDATE sleep=2000<CR> OK<CRLF>

 store (store settings to preset)
This command may be used to store current settings to 
a memory preset. The preset location to be updated is 
specified by using the address syntax. Addresses must 
be in the range 1 to 24. No data is transferred.

Example:

 REQUEST RESPONSE

 COMMAND store(3)<CR> OK<CRLF>

 version (firmware version)
This command may be used as a query to read the de-
vice firmware version number. The data is a string type.

Example:

 REQUEST RESPONSE

 QUERY version?<CR> OK “1.0.1”<CRLF>
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DMPA12 Audio Output Commands

Command Description

outdel Audio output delay 

outfault Audio output fault status 

outgn Audio output gain 

outgnfp Audio output Front Panel gain 

outiv Audio output phase invert 

outlb Audio output channel label

outlv Audio output level (dBu RMS) 

outmt Audio output mute status 

outmttog Audio output mute toggle 

outsrc Audio output channel signal source

Termination: all commands are terminated with an 
ASCII carriage return character (hex code 0x0D), rep-
resented by <CR> in the examples below. All responses 
are terminated with an ASCII carriage return, line feed 
pair (hex codes 0x0D, 0x0A), represented by <CRLF> 
in the examples below. An ellipsis (...) represents 
members of an array that have been omitted from an 
example for the sake of brevity. 

Verbose response: commands prefixed with an ex-
clamation point (bang) character result in a “verbose” 
response containing the name of the property or ac-
tion being addressed, along with the current values of 
the property in question. Property values are always 
returned in the “assignment” form, for example out-
mt(2)=1. This supports certain 3rd party control pro-
gramming styles where the response to all responses 
needs to be self-describing and/or contain current 
property values.

Examples: 

 REQUEST RESPONSE

 COMMAND !store(3)<CR> OK store(3)<CRLF>

 COMMAND !run={1,3,5}<CR> OK run={1,3,5}<CRLF>

 QUERY !outgn(3)?<CR> OK outgn(3)=0<CRLF>

 QUERY !outmt(*)?<CR> OK outmt(*)={0,1,1,...,0,0,0} 
  <CRLF>

 UPDATE !outgn(3)=0<CR> OK outgn(3)=0<CRLF>

 UPDATE !outmt(*)={0,1,1,..., 
 0,0,0}<CR> OK outmt(*)={0,1,1,..., 
  0,0,0}<CRLF>

outdel (output delay)
This command may be used as a query to read the out-
put channel delay, or as an update to set the delay. The 
output channel is specified by using the address syntax. 
Addresses must be in the range 1 to 12. The data type 
is integer, in the range 0 to 200, representing the time 
delay in one half millisecond increments. If the channel 
address is wildcarded, then the data type is an array 
of integer of size 12. In this case the value 999 may be 
used in an update to indicate that a particular output 
delay is to remain unchanged by the command.

Examples:

 REQUEST RESPONSE

 QUERY outdel(1)?<CR> OK 0<CRLF>

 QUERY outdel(*)?<CR> OK {0,44,0,...,0,0,0}<CRLF>

 UPDATE outdel(2)=100<CR> OK<CRLF>

 UPDATE outdel(*)={0,0,100,..., 
 0,0,999}<CR> OK<CRLF>

outfault (output fault status)
This command may be used as a query to read the 
output power amplifier fault status. The output channel 
is specified by using the address syntax. Addresses 
must be in the range 1 to 12. The data type is integer, 
either “1” meaning that the output is in a fault state, 
or “0” meaning that it is not. If the channel address is 
wildcarded, then the data type is an array of integer of 
size 12. 

Examples:

 REQUEST RESPONSE

 QUERY outfault(3)?<CR> OK 0<CRLF>

 QUERY outfault(*)?<CR> OK {1,1,0,...,0,0,0}<CRLF>

outgn (output gain)
This command may be used as a query to read the out-
put channel gain, or as an update to set the gain. The 
output channel is specified by using the address syntax. 
Addresses must be in the range 1 to 12. The data type 
is integer, in the range -70 to +20, representing the gain 
in dB. The value -70 has the special meaning Off. If the 
channel address is wildcarded, then the data type is an 
array of integer of size 12. In this case the value 99 may 
be used in an update to indicate that a particular output 
gain is to remain unchanged by the command.

Examples:

 REQUEST RESPONSE

 QUERY outgn(1)?<CR> OK -3<CRLF>

 QUERY outgn(*)?<CR> OK {3,-4,0,...,0,0,0}<CRLF>

 UPDATE outgn(2)=5<CR> OK<CRLF>

 UPDATE outgn(*)={0,-5,6,..., 
 0,0,99}<CR> OK<CRLF>
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 outgnfp (output front panel gain)
This command may be used as a query to read the 
output channel Front Panel gain, which is controlled by 
the knobs on the DMPA12 front panel. The output chan-
nel is specified by using the address syntax. Addresses 
must be in the range 1 to 12. The data type is integer, in 
a range determined by the Front Panel gain range set-
ting, representing the gain in dB. If the channel address 
is wildcarded, then the data type is an array of integer 
of size 12.

Examples:

 REQUEST RESPONSE

QUERY outgnfp(1)?<CR> OK 15<CRLF>

QUERY outgnfp(*)?<CR> OK {10,-3,5,...,0,0,0}<CRLF>

outiv (output phase invert)
This command may be used as a query to read the 
phase invert status, or as an update to set the status. 
The output channel is specified by using the address 
syntax. Addresses must be in the range 1 to 12. The 
data type is integer, either “1” meaning that the output 
phase is inverted or “0” meaning that it is not. If the 
channel address is wildcarded, then the data type is an 
array of integer of size 12. In this case the value 99 may 
be used in an update to indicate that a particular output 
gain is to remain unchanged by the command. Invert-
ing the phase is equivalent to reversing the polarity of 
the output and can be useful to correct for accidental 
polarity reversals in the wiring between an output and 
the speaker it drives.

Examples:

 REQUEST RESPONSE

QUERY outiv(3)?<CR> OK 1<CRLF>

QUERY outiv(*)?<CR> OK {0,1,0,...,0,0,0}<CRLF>

 UPDATE outiv(2)=0<CR> OK<CRLF>

 UPDATE outiv(*)={0,0,1,..., 
 0,99,99}<CR> OK<CRLF>

outlb (output channel label)
This command may be used as a query to read the out-
put channel text label, or as an update to set the label. 
The output channel is specified by using the address 
syntax. Addresses must be in the range 1 to 12. The 
data type is string, with a limit of 15 characters.

Note: String arguments in commands need to be 
passed in quoted form, contained in a pair of double-
quote (“) characters. A problem arises when using the 
outlb command to read or write a string that already 
contains double-quote characters, for example: The 

“Hula” Room. The solution is to escape the double 
quotes within The “Hula” Room so that it can be passed 
as a string argument for the outlb command. This is 
done by preceding the double-quote characters with a 
backslash character like this: The \”Hula\” Room. Now it 
can be passed as a string argument to the outlb com-
mand: outlb(1)=”The \”Hula\” Room”. Since the back-
slash serves as the escape character in quoted-string 
arguments, it too must be escaped if it is part of the 
string, so “foo\bar” would become “foo\\bar” . 

Examples:

 REQUEST RESPONSE

 QUERY outlb(1)?<CR> OK “Zone 3”<CRLF>

 UPDATE outlb(2)=”Gallery”<CR> OK<CRLF>

outlv (output level)
This command may be used as a query to read the 
output channel level. The output channel is specified 
by using the address syntax. Addresses must be in the 
range 1 to 12. The data type is integer, in the range -70 
to +20 representing the RMS audio level in dBu (on the 
internal voltage scale prior to digital to analog conver-
sion and power amplification). If the channel address is 
wildcarded, then the data type is an array of integer of 
size 12.

Examples:

 REQUEST RESPONSE

QUERY outlv(1)?<CR> OK -23<CRLF>

 QUERY outlv(*)?<CR> OK {3,-4,-66,...,0,0,4}<CRLF>

outmt (output mute)
This command may be used as a query to read the 
output channel mute status, or as an update to set the 
status. The output channel is specified by using the 
address syntax. Addresses must be in the range 1 to 
12. The data type is integer, either “1” meaning that 
the output is muted, or “0” meaning that it is not. If the 
channel address is wildcarded, then the data type is an 
array of integer of size 12. In this case the value 99 may 
be used in an update to indicate that a particular output 
mute is to remain unchanged by the command.

Examples:

 REQUEST RESPONSE

 QUERY outmt(2)?<CR> OK 1<CRLF>

 QUERY outmt(*)?<CR> OK {0,0,1,...,0,0,0}<CRLF>

 UPDATE outmt(1)=0<CR> OK<CRLF>

 UPDATE outmt(*)={0,1,0,..., 
 0,0,99}<CR> OK<CRLF>
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outmttog (output mute toggle)
This command may be used as a simple comand to 
toggle the output channel mute status. The output chan-
nel is specified by using the address syntax. Addresses 
must be in the range 1 to 12.

Examples:

 REQUEST RESPONSE

 COMMAND outmttog(1)<CR> OK<CRLF>

outsrc (output signal source)
This command may be used as a query to read the 
output signal source status, or as an update to set the 
status. The output channel is specified by using the ad-
dress syntax. Addresses must be in the range 1 to 12. 
The data type is integer, unless the channel address is 
wildcarded, in which case the data type is an array of 
integer of size 12. The following values are allowed:

•	 0 - 11  means that the output channel is fed by one 
of the 12 final mixes exposed by the Master DM se-
ries automixer in the system. Note that a zero based 
index is used to specify the mix.

•	 32  means that the output channel is fed by Expan-
sion Bus number 1

•	 33  means that the output channel is fed by Expan-
sion Bus number 2

•	 64  means that the output channel is fed by a 20Hz 
to 20kHz  0 dBu pink noise source

•	 65  means that the output channel is fed by a 300Hz 
to 20kHz  0 dBu pink noise source

•	 96  means that the output channel is fed by a 0 
dBu, 1 kHz tone source

In the case of an update with the channel address 
wildcarded, the value 99 may be used to indicate that a 
particular output source is to remain unchanged by the 
command. 

Examples:

 REQUEST RESPONSE

 QUERY outsrc(3)?<CR> OK 0<CRLF>

 QUERY outsrc(*)?<CR> OK {0,0,1,...,0,0,2}<CRLF>

 UPDATE outsrc(2)=2<CR> OK<CRLF>

 UPDATE outsrc(*)={0,0,1,..., 
 0,0,99}<CR> OK<CRLF>
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DMPA12 Output Compressor Commands
Command Description

outcpgn Output compressor gain 

outcpmug Output compressor makeup gain 

outcprat Output compressor ratio 

outcptc Output compressor time constant 

outcpthr Output compressor threshold level

 Termination: all commands are terminated with an 
ASCII carriage return character (hex code 0x0D), rep-
resented by <CR> in the examples below. All responses 
are terminated with an ASCII carriage return, line feed 
pair (hex codes 0x0D, 0x0A), represented by <CRLF> 
in the examples below. An ellipsis (...) represents 
members of an array that have been omitted from an 
example for the sake of brevity. 

Verbose response: commands prefixed with an ex-
clamation point (bang) character result in a “verbose” 
response containing the name of the property or ac-
tion being addressed, along with the current values of 
the property in question. Property values are always 
returned in the “assignment” form, for example out-
mt(2)=1. This supports certain 3rd party control pro-
gramming styles where the response to all responses 
needs to be self-describing and/or contain current 
property values.

Examples: 

 REQUEST RESPONSE

COMMAND !store(3)<CR> OK store(3)<CRLF>

 COMMAND !run={1,3,5}<CR> OK run={1,3,5}<CRLF>

 QUERY !outgn(3)?<CR> OK outgn(3)=0<CRLF>

 QUERY !outmt(*)?<CR> OK outmt(*)={0,1,1,...,0,0,0} 
  <CRLF>

 UPDATE !outgn(3)=0<CR> OK outgn(3)=0<CRLF>

 UPDATE !outmt(*)={0,1,1,..., 
 0,0,0}<CR> OK outmt(*)={0,1,1,...,0,0,0} 
  <CRLF>

 outcpgn (output compressor gain)
This command may be used as a query to read the 
compressor gain. The output channel is specified by us-
ing the address syntax. Addresses must be in the range 
1 to 12. The data type is integer, representing the gain 
in dB, which is always a negative value if the compres-
sor is active, or zero.

Example:

 REQUEST RESPONSE

QUERY outcpgn(1)?<CR> OK -11<CRLF>

 outcpmug (output compressor makeup gain)
This command may be used as a query to read the 
makeup gain, or as an update to set the makeup gain. 
The output channel is specified by using the address 
syntax. Addresses must be in the range 1 to 12. The 
data type is integer, in the range 0 to 30, representing 
the gain in dB. The allowable upper limit of makeup gain 
values is dynamically determined by the threshold and 
ratio settings of the compressor, and may be less than 
the absolute maximum of 30 dB. If the value sent in an 
update request exceeds this upper limit, it will be forced 
to the limit value.

Examples:

 REQUEST RESPONSE

QUERY outcpmug(1)?<CR> OK 5<CRLF>

UPDATE outcpmug(5)=12<CR> OK<CRLF>

outcprat (output compressor ratio)
This command may be used as a query to read the 
ratio, or as an update to set the ratio. The output chan-
nel is specified by using the address syntax. Addresses 
must be in the range 1 to 12. The data type is float, in 
the range 0.0 to 50.0, representing the compression 
ratio, with 0.0 meaning that the compressor is “off”.

Examples:

 REQUEST RESPONSE

QUERY outcprat(1)?<CR> OK 2.1<CRLF>

UPDATE outcprat(5)=5.55<CR> OK<CRLF>

outcptc (output compressor time constant)
This command may be used as a query to read the time 
constant, or as an update to set the time constant. The 
output channel is specified by using the address syntax. 
Addresses must be in the range 1 to 12. The data type 
is integer, in the range 5 to 10000, representing the 
time in one tenth millisecond increments.

Examples:

 REQUEST RESPONSE

QUERY outcptc(1)?<CR> OK 500<CRLF>

 UPDATE outcptc(2)=2000<CR> OK<CRLF>

outcpthr (output compressor threshold level)
This command may be used as a query to read the 
threshold, or as an update to set the threshold. The 
output channel is specified by using the address syntax. 
Addresses must be in the range 1 to 12. The data type 
is integer, in the range -80 to +20, representing the level 
in dBu.

Examples:

 REQUEST RESPONSE

QUERY outcpthr(1)?<CR> OK -3<CRLF>

UPDATE outcpthr(5)=-20<CR> OK<CRLF>
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DMPA12 Output Limiter Commands
Command Description

outlmgn Output limiter gain 

outlmtc Output limiter time constant 

outlmthr Output limiter threshold level

Termination: all commands are terminated with an 
ASCII carriage return character (hex code 0x0D), rep-
resented by <CR> in the examples below. All responses 
are terminated with an ASCII carriage return, line feed 
pair (hex codes 0x0D, 0x0A), represented by <CRLF> 
in the examples below. An ellipsis (...) represents 
members of an array that have been omitted from an 
example for the sake of brevity. 

Verbose response: commands prefixed with an ex-
clamation point (bang) character result in a “verbose” 
response containing the name of the property or ac-
tion being addressed, along with the current values of 
the property in question. Property values are always 
returned in the “assignment” form, for example out-
mt(2)=1. This supports certain 3rd party control pro-
gramming styles where the response to all responses 
needs to be self-describing and/or contain current 
property values.

Examples: 

 REQUEST RESPONSE

COMMAND !store(3)<CR> OK store(3)<CRLF>

COMMAND !run={1,3,5}<CR> OK run={1,3,5}<CRLF>

 QUERY !outgn(3)?<CR> OK outgn(3)=0<CRLF>

 QUERY !outmt(*)?<CR> OK outmt(*)={0,1,1,...,0,0,0} 
  <CRLF>

 UPDATE !outgn(3)=0<CR> OK outgn(3)=0<CRLF>

 UPDATE !outmt(*)={0,1,1,..., 
 0,0,0}<CR> OK outmt(*)={0,1,1,...,0,0,0} 
  <CRLF>

 outlmgn (output limiter gain)
This command may be used as a query to read the 
limiter gain. The output channel is specified by using the 
address syntax. Addresses must be in the range 1 to 
12. The data type is integer, representing the gain in dB, 
which is always a negative value if the limiter is active, 
or zero.

Example:

 REQUEST RESPONSE

 QUERY outlmgn(1)?<CR> OK -11<CRLF>

outlmtc (output limiter time constant)
This command may be used as a query to read the time 
constant, or as an update to set the time constant. The 
output channel is specified by using the address syntax. 
Addresses must be in the range 1 to 12. The data type 
is integer, in the range 1 to 5000, representing the time 
in one tenth millisecond increments.

Examples:

 REQUEST RESPONSE

 QUERY outlmtc(1)?<CR> OK 200<CRLF>

 UPDATE outlmtc(2)=1000<CR> OK<CRLF>

 outlmthr (output limiter threshold level)
This command may be used as a query to read the 
threshold, or as an update to set the threshold. The 
output channel is specified by using the address syntax. 
Addresses must be in the range 1 to 12. The data type 
is integer, in the range -50 to +20, representing the level 
in dBu.

Examples:

 REQUEST RESPONSE

QUERY outlmthr(1)?<CR> OK 10<CRLF>

 UPDATE outlmthr(5)=15<CR> OK<CRLF>
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DMPA12 Programmable I/O Commands
Command Description

prgin Programmable input state 

prgindef Programmable input definition 

prginundef Programmable input un-definition 

prgout Programmable output state 

prgoutdef  Programmable output definition 

prgoutiv Programmable output invert 

Termination: all commands are terminated with an 
ASCII carriage return character (hex code 0x0D), rep-
resented by <CR> in the examples below. All responses 
are terminated with an ASCII carriage return, line feed 
pair (hex codes 0x0D, 0x0A), represented by <CRLF> 
in the examples below. An ellipsis (...) represents 
members of an array that have been omitted from an 
example for the sake of brevity. 

Verbose response: commands prefixed with an ex-
clamation point (bang) character result in a “verbose” 
response containing the name of the property or ac-
tion being addressed, along with the current values of 
the property in question. Property values are always 
returned in the “assignment” form, for example out-
mt(2)=1. This supports certain 3rd party control pro-
gramming styles where the response to all responses 
needs to be self-describing and/or contain current 
property values.

Examples: 

 REQUEST RESPONSE

 COMMAND !store(3)<CR> OK store(3)<CRLF>

 COMMAND !run={1,3,5}<CR> OK run={1,3,5}<CRLF>

 QUERY !outgn(3)?<CR> OK outgn(3)=0<CRLF>

 QUERY !outmt(*)?<CR> OK outmt(*)={0,1,1,...,0,0,0} 
  <CRLF>

 UPDATE !outgn(3)=0<CR> OK outgn(3)=0<CRLF>

 UPDATE !outmt(*)={0,1,1,..., 
 0,0,0}<CR> OK outmt(*)={0,1,1,...,0,0,0} 
  <CRLF>

prgin (programmable input state)
This command may be used to simulate a momentary 
contact closure on a programmable input or as a query 
to read the state of programmable inputs. The program-
mable input is specified by using the address syntax. 
Addresses must be in the range 1 to 11. Note: simu-
lated contact closures have no effect for programmable 
inputs configured for analog gain control. The data type 
returned by queries is integer, with the possible values 
depending on the nature of the function assigned to the 
programmable input.

For analog gain control functions the values are the 
range 0 to 255, representing the voltage sensed by the 
programmable input (0 is 0 volts, 255 is 5 volts). For 
all other functions the value is either “1” meaning that 
the input is active (closed), or “0” meaning that it is not 
(open). The channel address may be wildcarded in que-
ries, in which case the data type is an array of integer of 
size 11.

Examples:

 REQUEST RESPONSE

 COMMAND prgin(11)<CR> OK<CRLF>

 QUERY prgin(9)?<CR> OK 1<CRLF>

 QUERY prgin(*)?<CR> OK {0,0,1,...,0,0,0}<CRLF>

 prgindef (programmable input definition)
This command may be used as a query to read a pro-
grammable input definition, or as an update to modify 
the definition. The programmable input is specified by 
using the address syntax. Addresses must be in the 
range 1 to 11. The data type is array of integer, with a 
variable length. The values contained in the array rep-
resent the definition of a programmable input, using the 
following scheme: 

•	 The	first integer is a code that specifies the func-
tion that is assigned to the programmable input. It 
may be in the range 0 to 8, with the following mean-
ings:

Code Function

0 No function assigned

1 Analog output gain control

2 Increment output gain 1 dB

3 Decrement output gain 1 dB

4 Recall preset from memory

5 Toggle mute on output

6 Momentary mute on output

7 Run a macro on close

8 Run macros on close/open

 The choice of function determines what happens 
when the programmable input is asserted. The 
choice of function affects the interpretation of the 
subsequent values in the array, which identify the 
target of the function.

 NOTE: All gain changes made by programmable 
input functions affect rear panel gain only.
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•	 The	remaining values specify the target of the 
function. These values are simply a list of one or 
more integers which identifies the thing(s) that are 
controlled by the function. The interpretation of the 
target values depends on the function that is as-
signed. The functions are as follows:

Analog output gain control 
A sequence of zero or more integers in the range 
1 to 12. These identify which output channels are 
to be controlled by the function. 

Increment output gain 1 dB 
A sequence of zero or more integers in the range 
1 to 12. These identify which output channels are 
to be controlled by the function. 

Decrement output gain 1 dB 
A sequence of zero or more integers in the range 
1 to 12. These identify which output channels are 
to be controlled by the function. 

Recall preset from memory 
A single integer value in the range 1 to 24. This 
identifies which preset is to be recalled by the 
function. 

Toggle mute on output 
A sequence of zero or more integers in the range 
1 to 12. These identify which output channels are 
to be controlled by the function. 

Momentary mute on output 
A sequence of zero or more integers in the range 
1 to 12. These identify which output channels are 
to be controlled by the function. 

Run macro on close 
A single integer value in the range 1 to 128. This 
identifies which macro is to be run by the function 
when the programmable input is asserted. 

Run macros on close/open 
Two integer values in the range 1 to 128. The first 
identifies which macro is to be run by the function 
when the programmable input is asserted. The 
second identifies which macro is to be run when 
the programmable input is subsequently de-as-
serted. 

Examples:

 REQUEST RESPONSE

QUERY prgindef(9)?<CR> OK {1,3,4,10}<CRLF>

(Function “Analog output gain control” is assigned to 
programmable input 9. The output channels under con-
trol are 3, 4, and 10.)

 REQUEST RESPONSE 

QUERY prgindef(2)?<CR> OK {7,22}<CRLF>

(Function “Run a macro” is assigned to programmable 
input 2. Macro number 22 will be run if the program-
mable input is asserted.)

  REQUEST RESPONSE

QUERY prgindef(4)?<CR> OK {0}<CRLF>

(No function is assigned to programmable input 4.) 

 REQUEST RESPONSE

UPDATE prgindef(11)={4,5} 
 <CR> OK<CRLF>

(Function “Recall preset from memory” is assigned to 
programmable input 11. The preset to be recalled is 
specified as number 5.)

 REQUEST RESPONSE

UPDATE prgindef(2)= 
 {5,1,2,4,5,6}<CR> OK<CRLF>

(Function “Toggle mute on output” is assigned to pro-
grammable input 2. The outputs to be controlled are 
specified as 1, 2, 4, 5, and 6.)

 REQUEST RESPONSE

UPDATE prgindef(4)={0}<CR> OK<CRLF>

(“No function” is assigned to programmable input 4, so 
that asserting it will have no effect.)

prginundef (programmable input un-definition)
This command may be used as an update to un-define 
one or more programmable inputs, meaning that it no 
longer has any function assigned to it. The data type is 
array of integer, with a variable length. The values con-
tained in the array represent the address of a program-
mable input to be un-defined. 

Example:

 REQUEST RESPONSE

UPDATE prginundef={3,4,5}<CR> OK<CRLF>

(Programmable inputs 3, 4, and 5 will be un-defined.)

prgout (programmable output state)
This command may be used as a query to read a pro-
grammable output state. The programmable output is 
specified by using the address syntax. Addresses must 
be in the range 1 to 8. The data type is integer, with 
the value either “1”, meaning that the output is active, 
or “0” meaning that it is not. If the channel address is 
wildcarded, then the data type is an array of integer of 
size 8.

Examples:

 REQUEST RESPONSE

QUERY prgout(5)?<CR> OK 0<CRLF>

QUERY prgout(*)?<CR> OK {0,0,1,...,0,0,0}<CRLF>
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 prgoutdef (programmable output definition)
This command may be used as a query to read a pro-
grammable output definition, or as an update to modify 
the definition. The programmable output is specified by 
using the address syntax. Addresses must be in the 
range 1 to 8. The data type is array of integer, with a 
variable length. The values contained in the array repre-
sent the definition of a programmable output, using the 
following scheme: 

The first integer is a code that specifies the function that 
is assigned to the programmable output. It may be in 
the range 0 to 3, with the following meanings:

Code Function

0 No function assigned

1 Monitor programmable input state

2 Monitor active preset

3 Monitor output fault status

The choice of function determines what conditions or 
events control the state of the programmable output. 
The choice of function affects the interpretation of the 
subsequent values in the array, which identify the event 
source which is monitored by the function.

The remaining values specify the source of the function. 
These values are simply a list of one or more integers 
which identifies the thing(s) that are controlled by the 
function. The interpretation of the source values de-
pends on the function that is assigned. The functions 
are as follows:

Monitor programmable input state 
A single integer in the range 1 to 11. This identi-
fies which programmable input is monitored by the 
function. 

Monitor active preset 
A sequence of zero or more integers in the range 
1 to 24. These identify which presets are to be 
monitored by the function. 

Monitor output fault status 
A sequence of zero or more integers in the range 
1 to 12. These identify which output channels are 
to be monitored by the function. 

Examples:

 REQUEST RESPONSE

QUERY prgoutdef(8)?<CR> OK {2,1,3,4}<CRLF>

(Function “Monitor active preset” is assigned to pro-
grammable output 9. The presets being monitored are 
1, 3, and 4.)

   REQUEST RESPONSE

QUERY prgoutdef(1)?<CR> OK {1,3}<CRLF>

(Function “Monitor programmable input state” is as-
signed to programmable output 1. The logical state of 
programmable input 3 is being monitored.)

  REQUEST RESPONSE

QUERY prgoutdef(3)?<CR> OK {3,1,7,8}<CRLF>

(Function “Monitor output fault status” is assigned to 
programmable input 3. The audio outputs being moni-
tored are channels 1, 7, and 8.)

 REQUEST RESPONSE

UPDATE prgoutdef(1)= 
 {1,5}<CR> OK<CRLF>

 (Function “Monitor programmable input state” is as-
signed to programmable output 1. The programmable 
input being monitored is specified as number 5.)

 REQUEST RESPONSE

UPDATE prgoutdef(2)= 
 {2,1,2,4}<CR> OK<CRLF>

(Function “Monitor active preset” is assigned to pro-
grammable output 2. The presets to be monitored are 
specified as 1, 2, and 4.) 

 REQUEST RESPONSE

UPDATE prgoutdef(4)={0} 
 <CR> OK<CRLF>

(“No function” is assigned to programmable output 4, so 
that it will become inactive.) 

 REQUEST RESPONSE

UPDATE prgoutdef(1)={3,3,4} 
 <CR>  OK<CRLF>

(Function “Monitor output fault status” is assigned to 
programmable output 1. The audio outputs to be moni-
tored are channels 3 and 4.

prgoutiv (programmable output invert)
This command may be used as a query to read the 
programmable output invert status, or as an update to 
set the status. The programmable output is specified 
by using the address syntax. Addresses must be in the 
range 1 to 8. The data type is integer, either “1” mean-
ing that the programmable output is inverted (contacts 
open when asserted), or “0” meaning that it is not 
(contacts closed when asserted, the normal case). If 
the address is wildcarded, then the data type is an array 
of integer of size 8. In this case the value 99 may be 
used in an update to indicate that a particular program-
mable output invert state is to remain unchanged by the 
command.

Examples:

 REQUEST RESPONSE

 QUERY prgoutiv(3)?<CR> OK 0<CRLF>

 QUERY prgoutiv(*)?<CR> OK {0,1,0,...,0,0,0}<CRLF>

 UPDATE prgoutiv(2)=1<CR> OK<CRLF>

 UPDATE prgoutiv(*)={0,0,1,..., 
 99,99,99}<CR> OK<CRLF>
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DMPA12 Front Panel Control
Command Description

fplock  Front Panel control lock

fpgnran  Front Panel control gain range

fpmten  Front Panel mute enable

fpmuted  Front Panel mute status

Termination: all commands are terminated with an 
ASCII carriage return character (hex code 0x0D), rep-
resented by <CR> in the examples below. All responses 
are terminated with an ASCII carriage return, line feed 
pair (hex codes 0x0D, 0x0A), represented by <CRLF> 
in the examples below. An ellipsis (...) represents 
members of an array that have been omitted from an 
example for the sake of brevity.

Verbose response: commands prefixed with an ex-
clamation point (bang) character result in a “verbose” 
response containing the name of the property or ac-
tion being addressed, along with the current values of 
the property in question. Property values are always 
returned in the “assignment” form, for example out-
mt(2)=1. This supports certain 3rd party control pro-
gramming styles where the response to all responses 
needs to be self-describing and/or contain current 
property values.

Examples:

 REQUEST RESPONSE

COMMAND !store(3)<CR> OK store(3)<CRLF>

COMMAND !run={1,3,5}<CR> OK run={1,3,5}<CRLF>

QUERY !outgn(3)?<CR> OK outgn(3)=0<CRLF>

QUERY !outmt(*)?<CR> OK outmt(*)={0,1,1,...,0,0,0} 
  <CRLF>

UPDATE !outgn(3)=0<CR> OK outgn(3)=0<CRLF>

UPDATE !outmt(*)={0,1,1,... 
 ,0,0,0}<CR> OK outmt(*)={0,1,1,...,0,0,0} 
  <CRLF

fpgnran (front panel control gain range)
This command may be used as a query to read the 
Front Panel control gain range, or as an update to set 
the gain range. The output channel is specified by using 
the address syntax. Addresses must be in the range 1 
to 12. The data type is integer, in the range 6 to 40, rep-
resenting the range of gain in dB, centered on 0 dB. For 
example, if 30 dB is specified, the result is a range of 
gain control from -15 to +15 dB. If the channel address 
is wildcarded, then the data type is an array of integer 
of size 12. In this case the value 99 may be used in 
an update to indicate that a particular output gain is to 
remain unchanged by the command.

Examples:

 REQUEST RESPONSE

 QUERY fpgnran(1)?<CR> OK 32<CRLF>

 QUERY fpgnran(*)?<CR> OK {40,40,20,...,16,16,16} 
  <CRLF>

 UPDATE fpgnran(5)=30<CR> OK<CRLF>

 UPDATE fpgnran(*)={40,40,20, 
 ...,20,99,99}<CR> OK<CRLF>

fplock (front panel control lock)
This command may be used as a query to determine if 
the DMPA12 Front Panel gain controls are locked (dis-
abled) or unlocked (enabled). It may also be used as an 
update to lock or unlock the controls. The output chan-
nel is specified by using the address syntax. Addresses 
must be in the range 1 to 12. The data type is integer, 
either “1” meaning that the output is locked (disabled), 
or “0” meaning that it is not. If the channel address is 
wildcarded, then the data type is an array of integer of 
size 12. In this case the value 99 may be used in an up-
date to indicate that a particular output gain is to remain 
unchanged by the command.

Examples:

 REQUEST RESPONSE

 QUERY fplock(3)?<CR> OK 1<CRLF>

 QUERY fplock(*)?<CR> OK {0,0,0,...,0,1,0}<CRLF>

 UPDATE fplock(2)=0<CR> OK<CRLF>

 UPDATE fplock(*)={0,0,0,..., 
 1,99,99}<CR> OK<CRLF>
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fpmten (front panel mute enable)
This command may be used as a query to deter-
mine the status of the front panel mute feature of the 
DMPA12. It may also be used as an update to set en-
able or disable this feature. If enabled, placing a front 
panel gain control in the fully counter-clockwise position 
will mute the audio on the channel. Otherwise the mini-
mum gain as determined as determined by the chan-
nel’s gain range will be applied. The output channel is 
specified by using the address syntax. Addresses must 
be in the range 1 to 12. The data type is integer, either 
“1” meaning that the feature is enabled, or “0” meaning 
that it is not. If the channel address is wildcarded, then 
the data type is an array of integer of size 12. In this 
case the value 99 may be used in an update to indicate 
that a particular output gain is to remain unchanged by 
the command.

Examples:

 REQUEST RESPONSE

 QUERY fpmten(3)?<CR> OK 1<CRLF>

 QUERY fpmten(*)?<CR> OK {0,0,0,...,0,1,0}<CRLF>

 UPDATE fpmten(2)=0<CR> OK<CRLF>

 UPDATE fpmten(*)={0,0,0,..., 
 1,99,99}<CR> OK<CRLF>

fpmuted (front panel mute status)
This command may be used as a query to determine 
the the front panel mute status of output channels. The 
output channel is specified by using the address syntax. 
Addresses must be in the range 1 to 12. The data type 
is integer, either “1” meaning that the channel has been 
muted from the DMPA12 front panel (by turning the gain 
knob fully counter-clockwise), or “0” meaning that it is 
not. If the channel address is wildcarded, then the data 
type is an array of integer of size 12.

Examples:

 REQUEST RESPONSE

 QUERY fpmuted(3)?<CR> OK 1<CRLF>

 QUERY fpmuted(*)?<CR> OK {0,0,0,...,0,1,0}<CRLF>



Reference Manual

Rio Rancho, NM 49

DMPA12 Rear Panel Control Commands
Command Description

rpoutgn Rear panel audio output gain 

rpoutgnmin Rear panel audio output gain minimum 

rpoutgnpre Rear panel audio output gain preset 

rpoutgnst Rear panel audio output gain step 

rpsave Save rear panel settings 

rprest Restore rear panel settings 

Termination: all commands are terminated with an 
ASCII carriage return character (hex code 0x0D), rep-
resented by <CR> in the examples below. All responses 
are terminated with an ASCII carriage return, line feed 
pair (hex codes 0x0D, 0x0A), represented by <CRLF> 
in the examples below. An ellipsis (...) represents 
members of an array that have been omitted from an 
example for the sake of brevity. 

Verbose response: commands prefixed with an ex-
clamation point (bang) character result in a “verbose” 
response containing the name of the property or ac-
tion being addressed, along with the current values of 
the property in question. Property values are always 
returned in the “assignment” form, for example out-
mt(2)=1. This supports certain 3rd party control pro-
gramming styles where the response to all responses 
needs to be self-describing and/or contain current 
property values.

Examples: 

 REQUEST RESPONSE

 COMMAND !store(3)<CR> OK store(3)<CRLF>

 COMMAND !run={1,3,5}<CR> OK run={1,3,5}<CRLF>

 QUERY !outgn(3)?<CR> OK outgn(3)=0<CRLF>

 QUERY !outmt(*)?<CR> OK outmt(*)={0,1,1,...,0,0,0} 
  <CRLF>

UPDATE !outgn(3)=0<CR> OK outgn(3)=0<CRLF>

 UPDATE !outmt(*)={0,1,1,... 
 ,0,0,0}<CR> OK outmt(*)={0,1,1,...,0,0,0} 
  <CRLF>

 rpoutgn (rear panel audio output gain)
This command may be used as a query to read the 
rear panel output gain, or as an update to set the rear 
panel gain. The output channel is specified by using 
the address syntax. Addresses must be in the range 
1 to 12. The data type is integer, in the range -61 to 0, 
representing the gain in dB (the feature acts as an at-
tenuator), where -61 has the special meaning “Off”. The 
actual allowable range of values is determined by the 
gain minimum and gain preset values. If the value sent 
in an update request exceeds the preset, it is forced the 
the preset value; if the value sent is less than the gain 
minimum, it is forced to the gain minimum value. If the 
channel address is wildcarded, then the data type is 
an array of integer of size 12. In this case the value 99 
may be used in an update to indicate that a particular 
rear panel output gain is to remain unchanged by the 
command.

Examples:

 REQUEST RESPONSE

 QUERY rpoutgn(1)?<CR> OK -3<CRLF>

 QUERY rpoutgn(*)?<CR> OK {-13,-4,0,...,0,0,0}<CRLF>

 UPDATE rpoutgn(2)=0<CR> OK<CRLF>

 UPDATE rpoutgn(*)={0,-5,0,... 
 ,0,0,-10}<CR> OK<CRLF>

rpoutgnmin (rear panel audio output gain 
minimum)

This command may be used as a query to read the 
rear panel output gain minimum, or as an update to set 
the gain minimum. All rear panel audio output gains 
are controlled by this minimum value. The data type is 
integer, in the range -61 to 0, representing the minimum 
gain in dB (i.e. the maximum attenuation possible using 
rear panel gain control). The value -61 has the special 
meaning “Off”, or infinite attenuation.

Examples:

 REQUEST RESPONSE

 QUERY rpoutgnmin?<CR> OK -30<CRLF>

 UPDATE rpoutgnmin=-15<CR> OK<CRLF>

rpoutgnpre (rear panel audio output gain preset)
This command may be used as a query to read the 
rear panel output gain preset, or as an update to set 
the gain preset. All rear panel audio output gains are 
controlled by this preset value, which is the value 
loaded when the device is powered up. The data type 
is integer, in the range -60 to 0, representing gain in dB 
(i.e. the minimum attenuation possible using rear panel 
gain control).

Examples:

 REQUEST RESPONSE

 QUERY rpoutgnpre?<CR> OK 0<CRLF>

UPDATE rpoutgnpre=-5<CR> OK<CRLF>
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 rpoutgnst (rear panel output gain step change)
This command is used as an update to step the gain 
by the amount specified, either up or down. The out-
put channel is specified by using the address syntax. 
Addresses must be in the range 1 to12. The data type 
is integer, in the range -6 to +6, representing the gain 
step in dB. If the channel address is wildcarded, then 
the data type is an array of integer of size 12. A positive 
value increments the gain, a negative value decrements 
the gain.

Examples:

 REQUEST RESPONSE

UPDATE rpoutgnst(2)=-2<CR> OK<CRLF>

 UPDATE rpoutgnst(*)={-2,-2,-2, 
 ...,-2,-2,-2}<CR> OK<CRLF>

 rprest (restore rear panel settings)
This command may be used to restore the state of rear 
panel settings previously saved with the rpsave com-
mand. If used as a simple command, all rear panel 
settings are overwritten with the saved values. If used 
as an update, the data type is an integer whose value 
serves as a mask which specifies which settings are 
restored and which are not. This mask has the same 
format as the preset mask. 

Examples:

 REQUEST RESPONSE

COMMAND rprest<CR> OK<CRLF>

UPDATE rprest=1<CR> OK<CRLF>

 rpsave (save rear panel settings)
This command may be used to save the current rear 
panel settings so that they can be restored at some 
future time by use of the rprest command. In this way a 
“snapshot” of the current rear panel gain and mute set-
tings can be taken prior to some temporary reconfigura-
tion of the device.

Example:

 REQUEST RESPONSE

COMMAND rpsave<CR> OK<CRLF>
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DMPA12 Command Grammar Rules
Augmented BNF[1] Rules for the LecNet2 command grammar:

OCTET = %x00-FF   ; <any 8-bit sequence of data>
CHAR  = %x01-7F   ; any US-ASCII character except NUL (1 - 127)
UPALPHA = %x41-5A   ; any US-ASCII uppercase letter “A”..”Z”
LOALPHA = %x61-7A   ; any US-ASCII lowercase letter “a”..”z”
DIGIT = %x31-39   ; any US-ASCII digit “0”..”9”>
LF  = %x0A      ; US-ASCII LF, linefeed (10)
CR = %x0D      ; US-ASCII CR, carriage return (13)
SP  = %x20      ; US-ASCII SP, space (32)
HT  = %x09      ; US-ASCII HT, horizontal tab (9)
DQUOTE = %x22      ; US-ASCII double-quote mark (34)
QCHAR  = %x01-21 / %x23-7F  ; any CHAR except DQUOTE

WS  = SP / HT
SIGN  = “-” / “+”
OFFSET  = 1*DIGIT / “*”
ALPHA  = UPALPHA / LOALPHA
ALPHANUM  = ALPHA / DIGIT
HEX   = “A” | “B” | “C” | “D” | “E” | “F” | “a” | “b” | “c” | “d” | “e” | “f” | 
DIGIT
STR_TOK  = ALPHA *(ALPHANUM)
INT_TOK  = *1SIGN 1*DIGIT
FLT_TOK  = *1SIGN *DIGIT “.” *DIGIT ; note that bare “.” is valid
QSTR_TOK  = DQUOTE *(QCHAR) DQUOTE
CRLF   = CR LF
OK_TOK  = %x4F %x4B ; uppercase string “OK”
ERROR_TOK = %x45 %x52 %x52 %x4F %x52 ; uppercase string “ERROR”

input  = (request / verb_request) *WS CR
output = (response / verb_response) *WS CRLF

request  = (query / hquery / update / target)
verb_request = “!” *WS (query / hquery / update / target)

query  = target *WS “?”
hquery  = target *WS “?” *WS “$”
update  = target *WS “=” *WS (argument / hargument)

status  = OK_TOK / ERROR_TOK
response = status *WS *1(argument / hargument)
verb_response = status *WS (target / update)

argument  = INT_TOK / FLT_TOK / QSTR_TOK / intarray / fltarray 
hargument = “$” 1*(*WS 2HEX) ; note that size of data must be > 0

target  = STR_TOK *1(*WS (arraydims | memloc))
arraydims = “(“ *WS arrayoffsets *WS “)”
memloc  = “[“ *WS 4HEX *WS “]”
arrayoffsets = OFFSET [ *WS “,” *WS OFFSET ]

intarray = “{“ *WS intsequence *WS “}”
intsequence  = INT_TOK *( *WS “,” *WS INT_TOK)

fltarray  = “{“ *WS fltsequence *WS “}” )
fltsequence = FLT_TOK *( *WS “,” *WS FLT_TOK)

[1] c.f. RFC 2234 <http://www.ietf.org/rfc/rfc2234.txt>



DMPA12 Digital Power Amplifier

LECTROSONICS, INC.52

Macros and Macro Control
The DMPA12 can be remotely controlled using com-
mands sent over USB, a serial port, or a network con-
nection.  An extensive text-based command language 
is defined for the DMPA12.  Touch panel controllers, for 
instance, use this command interface.

NOTE: Refer to the Online Help for details of using 
Macros as a powerful remote control option.

Macros are predefined groups of commands that are 
stored internally by the DMPA12.  All of the commands 
contained in the macro can then be executed by issuing 
a single Run command to the DMPA12.  There are two 
advantages to this approach:

Efficiency - only one command needs to be sent to 
the DM to execute complex actions, which may involve 
dozens of individual commands. 

Modularity - frequently executed sequences can be 
implemented as a macro which can be reused in other 
control designs, or combined with other macros to form 
complex actions. 

Macros are stored in the DMPA12 nonvolatile memory. 
128 macros are available, each are global in scope, 
meaning that they are not associated with any particular 
preset.

Macros may be given a descriptive title which is stored 
along with the command list.

It is important to know that when a macro is run, the 
response messages normally returned when the com-
mands are executed individually are discarded.   This 
means that ill-formed or unsuccessful commands fail 
silently, as the error message is discarded. 

Queries, commands which request information from the 
DM, make no sense within a macro.

Macros can be chained if necessary, meaning that 
one macro can call another macro by virtue of contain-
ing a run command. It is important to know that a run 
command issued from within a macro will be delayed 
until after the first macro has finished running. In other 
words, macros aren’t nested, they always run se-
quentially (chaining). The best practice when chaining 
macros is to make the run command the last command 
in a macro. 

The control panel contains a Macro Editor which is 
used to create new macros or edit existing ones when 
the PC is connected to a DM. Macros may also be 
opened and saved as files, making it possible to work 
with them in offline mode as well. 

The control panel also contains a Macro Recorder 
which allows a sequence of commands to be captured 
as a macro without typing them into the Macro Editor. 
The Macro Recorder works by capturing the commands 
generated by the control panel when the mouse and 
keyboard are used to make changes to the DMPA12 
settings. The macro recorder can be run while connect-
ed to a DM or used in offline mode to create command 
sets in advance of the installation.

Rear Panel Control with 
Hardware

The DMPA12 processor has programmable inputs 
which can be used to control a wide variety of functions. 
Depending on the function assigned to them, these  
programmable inputs may be connected to momentary 
contact switches, toggle switches, or potentiometers.  
When used with a switch, the inputs are activated by by 
connecting them to ground through the switch contacts, 
called a “contact closure”.  When used with a variable 
resistor, the inputs respond to the applied voltage in the 
range 0 to 5 VDC.

Another feature of the rear panel control interface are 
a set of programmable outputs which can be set up 
to indicate either programmable input status or other 
device parameters.  Programmable outputs act as an 
electronic “contact closure” to ground.  When the output 
is active, the contact is closed (conducting to ground).  
When the output is inactive, the contact is open (not 
conducting to ground). 

An important application of the rear panel control inter-
face is to manage what is called the rear panel gain for 
output audio channels.  This is an additional gain value 
that is added to the “main” gain value for a channel to 
give the total gain applied.  Rear panel gain is limited 
to the range -30dB to 0dB, and therefore is actually in-
tended to function as a variable attenuator for the audio 
channel. The purpose is to allow some amount of gain 
or level control by the end user in a safe manner, using 
one of the programmable inputs.

A typical application of rear panel gain is to allow 
adjustment of the level of an audio output (driving a 
speaker) downward from some maximum by means of 
turning a potentiometer connected to a programmable 
input which has been set up to use the Analog Output 
RP Gain Control function. 

Complete details on the use of Rear Panel control is 
provided in the Installation Guide and in the Control 
Panel GUI provided with the unit.



Reference Manual

Rio Rancho, NM 53



581 Laser Road NE   •  Rio Rancho, NM  87124  USA  •  www.lectrosonics.com
(505) 892-4501  •  (800) 821-1121  •  fax (505) 892-6243  •  sales@lectrosonics.com

22 July 2011

LIMITED ONE YEAR WARRANTY
The equipment is warranted for one year from date of purchase against defects in 
materials or workmanship provided it was purchased from an authorized dealer. This 
warranty does not cover equipment which has been abused or damaged by careless 
handling or shipping. This warranty does not apply to used or demonstrator equipment.

Should any defect develop, Lectrosonics, Inc. will, at our option, repair or replace any 
defective parts without charge for either parts or labor. If Lectrosonics, Inc. cannot 
correct the defect in your equipment, it will be replaced at no charge with a similar new 
item. Lectrosonics, Inc. will pay for the cost of returning your equipment to you.

This warranty applies only to items returned to Lectrosonics, Inc. or an authorized 
dealer, shipping costs prepaid, within one year from the date of purchase.

This Limited Warranty is governed by the laws of the State of New Mexico. It states the 
entire liablility of Lectrosonics Inc. and the entire remedy of the purchaser for any 
breach of warranty as outlined above. NEITHER LECTROSONICS, INC. NOR 
ANYONE INVOLVED IN THE PRODUCTION OR DELIVERY OF THE EQUIPMENT 
SHALL BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, CONSEQUENTIAL, 
OR INCIDENTAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE 
THIS EQUIPMENT EVEN IF LECTROSONICS, INC. HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL THE LIABILITY OF 
LECTROSONICS, INC. EXCEED THE PURCHASE PRICE OF ANY DEFECTIVE 
EQUIPMENT.

This warranty gives you specific legal rights. You may have additional legal rights which 
vary from state to state.


